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1 Introduction 

The Oasys Ltd LS-DYNA Environment 19.1 suite, dated October 2022, is a full release which 
supersedes all previous releases. It is a bug fix release of the Oasys Ltd LS-DYNA Environment 
19.0 suite. 

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 18.1). Each ‘Case ID’ referred to in these lists is unique and should 
be cited if more information or clarification are required. 

 

1.1 Compatibility with LS-DYNA releases 

The 19.1 release has been used and tested with LS-DYNA version R13 and the current 
development version. It supports all the keywords in volumes I, II and III of the released R12.0 
User’s Manual. Most of the new keywords in the released R13 User’s Manual are also supported.  

LS-DYNA R11.0 is the default keyword output format from PRIMER. (However, output may be 
generated for later releases of LS-DYNA.) 

 

1.2 Hardware platforms supported 

The complete Oasys Ltd LS-DYNA Environment 19.1 is available on the following platforms: 

Windows  Windows 10/11 64 bit 

Linux RedHat Enterprise 7.x, RedHat Enterprise 8.x 64 bit 

For simplicity of support and maintenance only the RedHat Enterprise 7.x build has been 
released on the website for Linux as this has been found to run on all the machines we have 
tested (RHEL 7, RHEL 8, SuSE 12.4). 

If you require a different Linux build, please contact Oasys Ltd. 

 

1.3 Graphics hardware supported 

The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware. 

‘Legacy’ X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine 
types. However, this X driver is not maintained or updated and will give poor performance, so it 
should only be used as a last resort.  There are much better ‘thin wire’ graphics solutions 
available today, and Oasys Ltd can give advice about these on request. 
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1.4 Licensing 

This latest version of the software will only use the LM-X licensing platform to provide an 
increased level of license security.  

To ensure you’re ready to enjoy all the great features Oasys Suite 19.1 will bring, we recommend 
you update all your Oasys Suite license servers and files as soon as possible.  

Action to take  

If you’re using a floating network license you will need to install the LM-X license server 
software (version 5.2). The software and supporting documentation are available to download 
from our website and are also included in our installation packages.  

Backwards compatibility  

The Oasys Suite 19.1 LM-X license file and license daemons are backwards compatible for all 
currently supported versions of Oasys Suite. This means that any existing 19.x, 18.x and 17.x 
software will continue to work with new LM-X license files and servers. 
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2 Bugs Fixed 

The enhancements and bug-fixes for each program have been broken down into a 
series of topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

2.1 PRIMER 

2.1.1 Bugs Fixed in 19.0 

Belts 

• Case 47037 

The seatbelt fitter has an optional 'initial depenetration' phase which attempts to sort 
out any small penetration errors in the belt path before the form-finding (fitting) 

process commences. This also tries to depenetrate any sections where belt paths inter-
penetrate, typically at the entry and exit points of sliprings, which requires it to choose 

which path segment should be 'in front' and which 'behind'. 

 
By default this in front / behind determination of overlapping belt segments is 

calculated automatically, using a majority voting algorithm. Occasionally it comes up 

with the wrong answer with the result that a belt path which is correct, even though it 
has no inter-penetrations, can end up being messed up by a spurious attempt at initial 

depenetration which tries to move the wrong belt path segment to the front. 
 

This has been fixed as follows: 

 
In V18.1 a 'behind' segment is only moved if it actually inter-penetrates, or is very 

close to doing so. Previously it would be moved even if it was quite a long way from 

inter-penetration. 
 

In V19 the same fix is applied, but in addition a new 'Settings...' set of options is 
provided for initial depenetration which permits the in front / behind status to be set 

manually, or turned off altogether. 

Checking 

• Case 48057 

Previously, once the Check Options panel's category has been changed to 'Other', the 
buttons 'Omitted keyword output data fields: [drop down box]' for this category 

remains on the panel even after the category has been changed to something else. This 
bug is now fixed. 
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• Case 47067 

Whilst PRIMER tests for collinear beam N3 there was no test for the case when a 
vector VXVYVZ is defined. It seems that LS-DYNA reports an error if the angle is 

less than 0.001 radian so this is now used for PRIMER’s error check. There is also a 

warning if the angle passes this test but is less than 1 degree. 

• Case 47040 

If *AIRBAG_REFERENCE_GEOMETRY for a node is defined but that node label 

has no actual *NODE card PRIMER correctly detects that the node is effectively 

'referenced but not defined'. 
 

Many versions ago this error detection used to have an auto-fix which would create 
the node using the reference geometry coordinates, but this auto-fix has ceased to 

work since (at least) PRIMER version 13. 

 
The fix for this is version-specific: 

 

In V18.1 an autofix has been added to this error when detected as part of the checking 
of *AIRBAG_REFERENCE_GEOMETRY, allowing all such nodes to be created 

automatically. 
 

In V19 a more extensive fix has been performed: 

 
- The autofix in *AIRBAG_REFERENCE_GEOMETRY checking mentioned above 

is added. 
- A similar autofix is added to *AIRBAG_SHELL_REFERENCE_GEOMETRY to 

create nodes referenced on shell cards, using the coordinates of the nodes on the 

actual shells. 
- The original check and autofix when checking *NODE cards has been reinstated, 

giving an alternative way of solving this problem. 

• Case 44813 

Database scalar keywords were not checked when performing a model check. This 
has been fixed. 

• Case 43878 

Previously, some places in PRIMER still referred to DYNA3D. These have now been 
updated to refer to LS-DYNA instead. 

 

The dialog box read commands: DK_DYNA3D_KEYWORD, 
DF_DYNA3D_FORMATTED; and write commands: DK_DYNA3D_KEYWORD, 
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DB_DYNA3D_KEYWORD; have been deprecated and replaced with: (read) 
DK_LSDYNA_KEYWORD, (read) DF_LSDYNA_FORMATTED, (write) 

DK_LSDYNA_KEYWORD, (write) DB_LSDYNA_KEYWORD; respectively. Any 

scripts, macros, etc. using the deprecated commands will still work, however they 
should be updated to use the new commands instead. 

Clipboard 

• Case 47382 

Now PRIMER copies IGA part properly when save as model with Find referenced 

items option is used in clipboard to new model. 

• Case 46703 

The Clipboard Merge into model and Save as model, model selector was not working 

after reopening the Clipboard. This has been fixed and a model can be selected by 
typing the model into the textbox or by using the model selector. 

Comments 

• Case 47327 

All ANSA comments were ending up in all include files, rather than just the ones 

originally in that include file. Fixed this issue. 

• Case 45155 

The problem of *COMMENT cards being written out multiple times was fixed during 

the work done for 'anchored' comment handling as part of case 45241. 

Contacts 

• Case 47826 

Ill-conditioned meshes, particularly those with trias, were giving spurious penetrations 
for single surface contact when soft = 0,1. This has been fixed. 

• Case 47042 

Use of SNRDE > 0 was incorrectly reported as error when SOFT=2. The check has 
been removed from v18. 

For v19 the check on SRNDE for SOFT=0,1 has been updated from remark 3 of the 

LS-DYNA manual on *CONTACT. 
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• Case 46779 

The logic that determines whether nodes of tiebreak contacts (with or without offset) 
tie has been revised to follow the tolerance calculation in the LS-DYNA manual. 

For MPP, this is contact thickness + 0.01*sqrt(2 x master segment area) 

Contour 

• Case 47577 

The position of text of contour bands was not correct when the dimensions of the 
graphics window were small, especially when the vertical dimension of the window 

was larger than the horizontal dimension.  This has been fixed. 

• Case 47559 

Fixed a typo in timestep contour setting. 
Fixed a false error for '<auto>' as values in Min/Max value boxes. 

Made 'Material Type' as consistent name in contour bar and setting strings. 
Fixed the Error button not being mapped in Mass Scale Setting Menu. 

Increased the width and relocated the 'Shell Intg Pt' menu for 'element prop'->'plastic 

strain'. 

Crash test setup 

• Case 47057 

Test images in the crash test setup script could appear small on 4k monitors. They 

now fill the whole frame like they do on a standard monitor. 

Curve menu 

• Case 45949 

The K button in the loadcurve edit panel is designed to automatically load the 
keyword manual on the page that's appropriate for a particular curve or function 

subtype. This logic was incorrect for two of the curve subtypes which would cause the 
manual to open on the wrong page (still in the *DEFINE_CURVE section though). 

This has now been fixed. 
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Cut section 

• Case 46807 

The thick shell capping case showed incorrect capping for contact thickness shells and 
cut-section ON hindered switching to optt/sft thick plot. Fixed it. 

• Case 46684 

The graphics did not always update correctly when there were multiple cut sections.  

This has been fixed. 

• Case 46682 

PRIMER was not always selecting entities correctly when there were multiple cut 

sections. This has been fixed. 

• Case 46430 

Shell 'True Flat' could not be turned on whilst a cut section was turned on. This has 
been fixed.  

Made True Beam Sections settings in display options and cut-section panel dependent 
on each other. 

• Case 45316 

Suppose that a cut plane intersects a shell such that one of its nodes is exactly on the 

plane and the adjacent nodes are on different sides of the plane. In that situation the 
intersection line segment of the shell with the plane was not drawn in PRIMER. Now 

it is drawn in the same way as for other (more general) positions of nodes relative to 

the plane. 

Damping 

• Case 46488 

Added a radio button box in *DAMPING_PART_MASS and 

*DAMPING_PART_STIFFNESS create panel, through which the user is now able to 
create single or multiple definitions. 

Deleting 

• Case 46803 

Added macro tags for 'Delete Recursive' & 'Remove From Sets' check-box in the 

delete pop-up in keyword editor. 
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Edit 

• Case 47261 

PRIMER was not showing optional cards 5, 5.1 and 5.2 in SECTION_SHELL when 
required. This has been fixed. 

• Case 47197 

Previously, for some open-ended style keywords whose scalar editors would add a 

single new entry field at a time (*DEFINE_DRIFT_REMOVE, for example), 
PRIMER would hang if the last field of a row was set to 0 while there were still some 

populated fields in the next row. This has now been fixed. 

• Case 46693 

Scroll bar in ICFD_SET_NODE keyword was not extending after making 56 entries 
in View/Edit mode. Now scrollbar kicks in after making 56 entries. 

Elements 

• Case 43694 

Zero length discrete beams have a negative N2 label, with N2=-N1. This was not 
correctly handled before. When renumbering the node, N2 was lost. And when 

merging 2 models, which implies node renumbering, error messages were displayed. 

Encryption 

• Case 47450 

Encrypted data was being lost when merging models that both had encrypted PGP 
data.  This has been fixed. 

Error trapping 

• Case 46589 

PRIMER issued a confusing error message if it read a model with a blank line that 

shouldn’t be there. It printed two line numbers, the first of which was misleading.  
This has been fixed. 

 

 



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 19.1 

 

Ove Arup and Partners Limited | Final | October 2022  

 

Page 9 
 

Frequency 

• Case 46789 

PRIMER gave a wrong error about missing data on 
*FREQUENCY_DOMAIN_RANDOM_VIBRATION (for fields in card 7) when the 

_FATIGUE option was not selected. Now fixed. 

General 

• Case 47867 

The LS-DYNA submission via the PRIMER 'Submit' panel was not happening for 
keyword files with extensions other than '.key'. Fixed this. 

Graphics 

• Case 47635 

When rendering points to display beam end releases sometimes PRIMER would not 

draw those points to correct size especially on a low resolution display, it would at 
times take a size larger than specified. This has been fixed. 

• Case 47607 

oa_pref options for graticule and overlay colours were not getting written out. This 
has been fixed. 

• Case 47606 

A *DATABASE_CROSS_SECTION keyword created normal to a feature line could 

have the normals facing in one direction, then on clicking the '+' button to move it the 
database would move in the -ve direction and normals would switch direction. This 

has been fixed. 

• Case 47580 

In the rigidwall edit panel, when modifying values, the graphics of the rigidwall were 
not updating immediately. Pressing 'Update' or forcing a redraw was necessary. This 

has been fixed. 

• Case 47579 

The screen text generated by the Mesh Volume Analysis tool was always coloured 

black, which meant it was not visible when the background was black. PRIMER now 

changes the colour from black to white if a black background is used. 
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IGA 

• Case 47713 

PRIMER wrote out a single keyword header for 
*SECTION_IGA_SHELL/IGA_SOLID for multiple entries, but this resulted in some 

warning messages when run in LS-DYNA.  A keyword header is now written for each 

entry. 

• Case 46035 

The trimming curve on a surface was not being processed correctly when tessellating, 

caused by a very thin tria with a short edge on the trim curve.  A tolerance has been 

increased to avoid this issue and a 'glum_vertex_tol' preference has been added to 
give some control to the user over this issue. 

Include 

• Case 47104 

When an include file is deleted, model modified will now red-light the parent include 
as modified, when you use the 'find modified' tool. 

• Case 47088 

Now that compression to .gz and .zip format is an option in PRIMER this raises the 

question of how compressed filenames should be referred to in *INCLUDE 
statements and also how they should appear in the user interface. 

 

In V18 and earlier they were always referred to by the 'raw' names, for example if we 
read child.key.gz we still referred to it as child.key in the GUI and in *INCLUDE 

cards. This caused some confusion since it wasn't always clear from the GUI that a 
file was compressed; it also wasn't clear which had been read when multiple versions 

of a file were present on disk, for example if both child.key and child.key.gz were 

present. To address these issues the following changes have been made: 
 

The GUI now provides warnings and feedback in four separate places when some 
variant of a filename has been read. Locations (1) to (3) are new in V19, location (4) 

was in V18. 

 
(1) In the INCLUDE tree the actual file read (for example child.key.gz) is now listed 

first with the raw name (eg child.key) appended. There are symbols to denote 

compression and binary, and also a warning symbol if the file read is not the raw 
name in the include statement or there were multiple doppelganger candidate 

filenames. Hovering over such a row gives details of the differences. 
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(2) In the PART tree there is a cut-down version of the above. The actual file read 

rather than the raw name is reported with a [*] after it to act as a warning, and 

hovering over that row gives details. 
 

(3) In Model Check there are three new categories of warning for include files: 

 
- If the file as read is compressed / binary and therefore would not be directly readable 

into LS-DYNA. 
 

- If the raw filename could not be found but a single alternative filename, found by 

fuzzy-matching the name, has been read instead. 
 

- If there were multiple variations of the filename. 

 
In all cases asking for 'details' (or 'explain') will list the various filenames in detail 

explaining what was actually read. 
 

(4) In the pre-output check panel a model which will not read into LS-DYNA because 

of compression/binary is highlighted in red, hover over gives details. 

JavaScript API 

• Case 47926 

The onChange property was not available for comboboxes in the GUI Builder 

properties window. This has been fixed. 

• Case 47743 

JavaScript API SSH function 'Execute' was not giving out the 'status' property from 

the returned JS-Object. Fixed this. 

• Case 47375 

A new property addKeywords has been added to the Material class to obtain the 
number of *MAT_ADD cards that are defined for a material. Additionally the 

Keyword and KeywordCard methods in the Material class can now take an optional 

integer argument to return the *MAT_ADD data. 

• Case 46780 

PRIMER could crash, due to an error in the SetTableEntry() method in the Curve 

class. This has been fixed. 
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• Case 46472 

Updating a parameter could sometimes fail if the model contained invalid parameter 
expressions. If this happened an exception was not thrown correctly. This has been 

fixed. 

In addition, new methods SaveAll() and UpdateAll() have been added to the 
Parameter class to enable multiple parameters to be changed before PRIMER updates 

the model. 

• Case 46011 

Fixed a JavaScript API bug for *CONTACT where the get and set functions for fields 
SBOXID and MBOXID were not handling negative values and parameters correctly. 

• Case 46010 

Fixed a bug in keyword *CONTACT when the SOFT field value was erroneously 
changed when the VSF field value was edited by JavaScript. Now editing the VSF 

field with JavaScript does not affect the SOFT field value. 

• Case 45259 

Support for ES6 modules has been added. 

Keyword 

• Case 47510 

Previously, PRIMER would issue a warning regarding the omission of an invalid 

*FREQUENCY_DOMAIN_RESPONSE_SPECTRUM field, RELATV, when 

writing the keyword out in versions prior to R11 (except for 971R6) even when the 
field had not been set (was zero). This has now been corrected such that the warning 

is only issued if the field is non-zero. 

• Case 47509 

If there was no data on card 3 of *CONTROL_THERMAL_SOLVER PRIMER 

issued a warning about it being invalid.  It should have only issued the warning if 

there was some data in card 3.  This has been fixed. 

• Case 47442 

Changed card 1 field 8 from OUTPUT to INICRT for the <none> suffix of 

*MAT_COHESIVE_MIXED_MODE_ELASTOPLASTIC_RATE (MAT_240). 
However, the field will be treated out as OUTPUT when writing out models for 

versions <R8. 
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• Case 47391 

*BOUNDARY_PRESCRIBED_KEYWORD keyword panel previously did not grey 

out Card 3 when the card was not being used, for example when field DOF was not 9 

to 11 or -9 to -11, or when field VAD was not 4. This is now fixed. 

• Case 47333 

Changed keyout version of _FILE option for DATABASE_BINARY_INTFOR from 

R11 to R9. 

• Case 47317 

Removed the erroneous OPTION2=<_MODAL_CONTRIBUTION> option for 
certain DATABASE_FREQUENCY_ASCII_<Option1> types. 

• Case 47166 

New fields PERMY and PERMZ have been added to field 3 and 4 of 
*MAT_ADD_PERMEABILITY to keyout in PRIMER for R12 and above keyword 

files. 

• Case 46669 

Extended the VID field for DDAM option for 
*FREQUENCY_DOMAIN_RESPONSE_SPECTRUM to accept values less than 0 as 

vector id. 

Keyword editor 

• Case 47508 

*BOUNDARY_NON_REFLECTING_2D fields 2 and 3 (AD, AS) were incorrectly 
written as floats. They have been changed to integers. 

• Case 46064 

The keyword editor will now auto-dynamically resize upon changing suffices/field 
values. 

Labels 

• Case 47804 

Corrected a typo in Label warning popup. 
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Loadcurves 

• Case 45827 

The DEFINE_TABLE_MATRIX edit panel could previously, on rare occasions, 
display buttons corresponding to other Table types. This has now been fixed 

• Case 45818 

The Table edit panel sees the following (minor) tweak. The header for the textbox that 

allows entry of curves (for TABLE and TABLE_2D) and tables (for TABLE_3D, …, 
TABLE_9D) now displa‘s 'Curve’ID' ‘r 'Table’ID' text as appropriate where, 

previously,’it'd unconditionally sh‘w 'L’ID' 

Macro 

• Case 47237 

The wrong macro tag was getting picked up when clicking on Measure->Node Curve-
>Free edge node curve. This has been fixed. 

• Case 35445 

Macro tags have been added to the pairs of listing, details and autofix buttons to 
distinguish them in the main checking panel. 

Manual 

• Case 45799 

Opening the keyword manual from PRIMER for *BATTERY and *DUALCESE 

keywords did not work. This has been fixed. 

Mass 

• Case 46372 

Mass property function has been corrected to ignore mass on N3 nodes of beams that 

are otherwise non-structural. This is consistent with Assign Mass. 

Materials 

• Case 47836 

PRIMER crashed if you imported materials from a database (MAT->Import) and then 
went to MAT->Modify. This has been fixed. 
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• Case 47724 

The ISW field on *MAT_185 can be blank for non-XFEM shells, but PRIMER issued 
a warning. This has been fixed and PRIMER now only issues a warning if it’s blank 

and used in XFEM shells. 

• Case 47374 

Fixed load curve selection on MAT_ADD_GENERALIZED_DAMAGE LCREG3, 
FADEXP3, and ECRIT3 fields. 

• Case 46760 

Tabbing through the material edit panel reset the type to ELASTIC possibly losing 

extant data. This has been fixed so that whilst tabbing temporarily clears the entry in 
the type box, tabbing past it will restore the correct type and no other data will be lost 

• Case 44529 

The FN field *CONSTRAINED_SPR2 can be a -ve label pointing to a material, but 
PRIMER did not support this. This has been fixed. 

Measure 

• Case 47771 

The distance on a measurement drawn in the graphics window was initially shown 

‘s’'0' until the graphics were refreshed. This has been fixed and the correct 
measurement value is now shown immediately. 

• Case 47147 

PRIMER’s Measure->Node Curv’->'Free edge node cu’ve' option calculated the 

incorrect value of the whole perimeter of a curve when a node was double clicked. 
This has been fixed. 

Mechanism 

• Case 46651 

A mechanism with a coupler was moving the wrong way. This has been corrected. 

• Case 41821 

A mechanism could be slow to move whilst moving a connection. This has been 

improved. 
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Menus 

• Case 47277 

There are Database scalar cards which are only permitted to have a single instance in 
a model. If there were multiple models open in PRIMER with all of them having one 

instance of these Database cards the create button would still be active. This has been 

fixed and the create button is greyed out and the modify button is active instead. 

• Case 46386 

It was not possible to select text in buttons within buttons, e.g. those at the bottom of 

the assign mass panel. This problem has now been fixed. 

Mesh 

• Case 46634 

Solid and thick shells were not always aligned with the parent triad after splitting 
them. This has been fixed. 

• Case 46346 

In Mesh tools > Shell > Split panel, Node selection button was not greyed out for 
Solid and Tshell. This has been fixed. 

• Case 39032 

Node-drag with element quality contouring turned on was slow on large models. This 

has been fixed. 

Model modified 

• Case 44272 

Model modified has been improved to report differences for the case where one model 

has an installed item and other has a latent item of the same label. This could have 

been missed before, depending on the way round the models are compared. 

Morphing 

• Case 46793 

Moving morphing control nodes did not update 

*ELEMENT_SHELL_NURBS_PATCH geometry. This has been fixed. 
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Node 

• Case 46087 

PRIMER could crash when writing *NODE_MERGE cards, now fixed. 

Orient 

• Case 47385 

Orienting a model did not move *IGA parts.  This has been fixed so that that the 

orient options such as translate, rotate, scale and reflect now work for *IGA parts. 

Parameter 

• Case 47292 

Previous versions of PRIMER could, at times, not read in implicit parameters 
correctly. This issue has now been fixed. 

• Case 47220 

Previously, scalar editors for the below (semi-)open-ended keywords, in which a 

single new entry field was made available at a time, would not class a zero-value 
parameter reference as valid input and hence not create a new entry field. For these 

keywords, PRIMER would also ignore any open-ended fields that referenced a zero-
value parameter upon reading, and so this data would be lost. These issues have now 

been fixed. 

 
*CONSTRAINED_IMMERSED_IN_SPG 

*DEFINE_DRIFT_REMOVE 

*FREQUENCY_DOMAIN_LOCAL 
*IGA_1D_BREP 

*IGA_2D_BREP 
*IGA_FACE_UVW 

*IGA_FACE_XYZ 

• Case 46473 

PRIMER has a limited capacity to handle character parameters used as filenames. So 
long as the parameter is on a line by itself this will work, so the syntax 

 
*INCLUDE 

pathname/ + 

parameter 
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Works when an include filename is parameterised when appended to an explicit path. 
 

However this parameterisation was lost on keyout with just the plain 

pathname/filename being written instead because of a rather limited way of 
interpreting parameters in this context. 

 

This is now fixed and output will be in the 
 

*INCLUDE 
pathname/ + 

&param 

 
form, even if the actual pathname changes. 

• Case 46330 

PRIMER v18 added support for the processing of pseudo-expressions that take the 

following form: 
*PARAMETER 

R y15 z30 
 

This carried the limitation that only one such expression would be processed per line 

as opposed to the usual limit of 4 for regular parameters. 
 

v19 removes this limitation and allows a mix of pseudo-expressions and regular 
parameters to be defined on a line. So, the following would be processed correctly in 

v19: 

*PARAMETER 
R z30 -10.0 

R x75 75.0 

$R y15 x75 
*PARAMETER 

R y15 z30I a30 987R b49 &z30R c62 3.14 

• Case 39167 

PRIMER now correctly handles regular (non-expression) parameters that are, 

effectively, pseudo-expressions and take the form: 

*PARAMETER 
R var2 var1 

 



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 19.1 

 

Ove Arup and Partners Limited | Final | October 2022  

 

Page 19 
 

Part replace 

• Case 46383 

A trap has been added in part replace to report any target elements which are 
connection entities. These cannot be deleted and suggest that the post-end connection 

definition has been corrupted. 

Pedestrian 

• Case 47033 

Previously, when using the N points calculation method for a leg impacts in the 
Pedestrian Markup tool, setting the spacing to a greater value than the number (N) of 

points would result in the tool breaking. This is now fixed. 

Program crash 

• Case 47966 

PRIMER could crash when screen picking knots in the 
*ELEMENT_SHELL_NURBS_PATCH editor if the definition was not valid. A 

check is now made to make sure it is valid and a warning is issued if it is not. 

Read 

• Case 47035 

If a keyword file is created (somehow...) in which the last line is not terminated by a 

[line feed] character then PRIMER would fail to read any content on this last line, 

effectively marking the file as having ended prematurely. This has been fixed. 

• Case 45654 

Fixed an issue where PRIMER would be unable to read-in or write-out a 

*DEFINE_CPM_VENT keyword where field VANG was not -2, and values in the 

optional 3rd row were present. Also removed the requirement for NID values to be 
present when VANG=-2 in the keyword edit panel, as this is not a condition required 

for writing out in LS-DYNA version R9. 

Renumber 

• Case 47803 

PRIMER was getting stuck in an infinite loop when accidentally moving mouse into a 

white area before clicking Only/Blank/Sketch etc in the Renumber Visualise panel. 
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Rigidify 

• Case 47065 

MAT77 can use a -ve Poisson ratio to change the format of the card. The applied 
value is positive. PRIMER’s contour plotting of material properties incorrectly 

contoured a -ve value. Also the Rigidify function incorrectly imported the -ve value 

resulting in LS-DYNA initialization fail. Both these have been corrected. 

Scripting 

• Case 44250 

D3PLOT, PRIMER and T-HIS would previously allow encryption of an open 

(unencrypted) script that, however, refers to an already-encrypted script. No warnings 

would be thrown during this operation but the resulting encrypted (parent) script 
would be unusable. This scenario is now detected up-front, a warning thrown, and the 

(illegal) encryption operation aborted. 

• Case 47777 

PRIMER release scripts using pre-packaged macros have been updated to work when 

a user is using the new Favourites menus for Tools and/or Keywords. 

• Case 47653 

PRIMER crashed when trying to delete the model created after running the HPM 
script or trying to rerun the script. This has been fixed. 

• Case 45811 

Automatic timeouts have caused problems by shutting down prematurely a batch 

processes running a very long script when the time taken exceeds the timeout limit. 
To solve this the following changes have been made: 

 
+ All of PRIMER, D3PLOT and T-HIS will now accept the command-line argument -

d=batch. This has the following effects: 

 
- No graphics window will be mapped on the display. In D3PLOT and T-HIS 

graphical operations such as image creation may still be performed, they just won't be 
visible. 

 

- The timeouts functionality will not be active. The process will not be killed no 
matter how long it runs. 

 

In addition to the above when a process is auto-terminated by the timeouts feature a 
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message is sent to the LMX licence server log file stating: 
 

Process name and version 

Machine name 
Process id 

Reason for auto-termination. 

Sections 

• Case 47121 

For *SECTION_IGA_SHELL, *SECTION_SHELL & *SECTION_TSHELL beta 
angle field name boxes were greyed out, ICOMP pop-up couldn't switch from 1 to 0 

and beta angle fields did not disappear for icomp=0 in the create editor. IRL, PROPT 
and ICOMP field pop-ups weren't implemented in kwd editor.  These have all been 

fixed. 

Sensor 

• Case 47198 

In *SENSOR_SWITCH_SHELL_TO_VENT the associated label while reading it 
into PRIMER was clashing with other labelled *SENSOR_SWITCHs and ABID was 

given a SWITCH label instead of Airbag ID. This has been fixed. 

• Case 47169 

PRIMER was replacing parameter names with the parameter value in some of the 
fields in *SENSOR_CPM_AIRBAG.  Additionally, PRIMER reported errors for 

some fields when they were empty even though it was valid. These have been fixed. 

• Case 47162 

In *SENSOR_DEFINE_ELEMENT_SET a blank value for <SETOPT> field was 

being set to 'AVG'. This has been fixed. 

Sets 

• Case 47414 

In *CONTACT_COUPLING illegal values could be set for stype (not in range of 0-3) 
if it was set with a parameter.  PRIMER now reports a warning saying that the 

parameter value is not in range and the popup for sid is no longer available. 
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Sketch 

• Case 47308 

After using reset prefs function, the sketch colour was incorrectly set to white. Now 
fixed. 

Speed 

• Case 45746 

Models can have 'complicated' sets which are slow to process. Typically, these are 

*SET_xxx_GENERAL using multiple box and other computationally intensive 
operations which make it slow to determine what the set's contents actually are. 

 

PRIMER tries to speed this up by building a cache of the set's contents, but obviously 
this has to be built in the first place and also updated as the model is modified. This 

cache build/maintenance process was very slow in some situations and this has been 
speeded up. 

Text 

• Case 47546 

Cards 3 and 2b for CONTROL_THERMAL_SOLVER can now be accessed with the 

Text Editor if Solver is set to 17, this was previously not possible. 

Transform 

• Case 47704 

Previously, when a *NODE_TRANSFORM card was deleted, the graphics was not 

getting updated. Deleting a *NODE_TRANSFORM card now will remove the 

transformation it contained and update the graphics. 

Units 

• Case 47505 

Unit conversion for fields ERATEN and ERATES was not working in keyword 

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK
. This has been fixed. 
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User interface 

• Case 47812 

Width of the Columns under View in Connection table now increased to make row 
text clearly visible. 

• Case 47737 

When pressing 'Recheck' in the Check panel, the cells that had errors in the previous 

check appeared in red. This was not correct. Now they only turn red after the recheck 
has taken place if errors have been found. 

• Case 47705 

After doing a model merge, it was no longer clear whether the Copy and Omit buttons 

on the model data panels were toggled on or off in the new user interface. The 
red/green colour distinction has now been improved and the panels have generally 

been made more consistent with the overall UI. 

• Case 47593 

In the RENUMBER SELECTED panel, the 'YES' & 'NO' buttons have been joined 

since they are mutually exclusive. 

• Case 46925 

The vertical dimension of the Create panel for DAMPING_PART_STIFFNESS was 
too small to show the list of parts. This has been fixed. 

• Case 46866 

The 'Read & Apply file' buttons were coloured incorrectly. This has been fixed. 

• Case 46854 

The 'List' button in the Part Tree box was not highlighted when clicking the Contents 
right-mouse-button popup List option. This has been fixed. 

• Case 46852 

Fixed the following issues: 
1. On the DEFINE_TRANSFORMATION editor, the +/-/^/v buttons sometimes 

flickered between having rounded and square corners when hovered. The buttons also 

reset to rounded button style when the panel was remapped. 
2. On the Orient menu, the 'Consider INCL_TRANS' label and tickbox overlapped. 

This causes the tickbox border to disappear and reappear when moving the mouse 
over one then the other. 
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• Case 46851 

Labels for a few radio button boxes in Model -> Build were to the right of the box. 
Repositioned them to the top of the box. 

• Case 46827 

Renamed button 'Dyna' in Safety -> Dummies -> Position to 'LS-DYNA'. 

• Case 46819 

Made the radio button in the MAKE CONNECTIONS panel wider so that the 'Master 
Part Set' option is fully visible. 

• Case 46721 

The help button on the Rigidify panel was a regular button with the string 'help' on it, 

rather than the more typical '?' next to the 'X' button. Also, the panel heading string 
'Rigidify' did not come up for no model or more than one models. This has been fixed. 

• Case 45990 

Fixed a bug where the drop-down menu for field CID in keyword 
*ELEMENT_MASS_MATRIX was not opening correctly. 

• Case 45923 

PRIMER's object menus provide 'hover over' graphics which highlight in the graphics 

window the item(s) in the row where the mouse is currently located. For simple items 
the time taken to draw these graphics is effectively instant, but for more complex 

items it can take quite a long time to render the graphics - often several seconds. 

 
This used to cause a problem because as soon as the mouse landed on a new menu 

row it would not respond to subsequent movement until all the graphics for that row 
had been drawn. This showed up most clearly for complex items like *CONTACTs or 

*SET_PARTs, but it could be a problem for other types too. 

 
This rendering process has been modified so that instead of a 'draw it all in one go' 

approach the code now uses repeated cycles of 'draw a little bit, then see if the mouse 
has moved'. This allows it to detect that the user has moved the mouse position, and if 

this is detected as having moved to a different row then rendering of the 'old' graphics 

can be ended prematurely. 
 

All of which is a rather complicated way of saying that when scrolling through object 

menus of complex items the response to mouse motion should no longer be delayed. 
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• Case 45919 

The items of the comboboxes in scripts sometimes had the colour that the user had 
specified in the background and foreground properties. However, they should have 

respected the category, unless they are specifically given the category 

NO_CATEGORY.  This has been fixed. 

• Case 45553 

The X and Y labels of the graphs in DEFINE_CURVE was not centred, and this made 

them go outside the graph when it was too long. This happened when the curve was 

being used in multiple different keywords. Now it is always centred. 

Xref 

• Case 47068 

Some parameters used in the *DEFINE_CURVE_FUNCTION expression strings 

were not being found in the Xrefs panel list. This has been fixed. 
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2.1.2 Bugs fixed in 19.1 

Attached 

• Case 47805 

Sometimes a scroll bar failed to map on the Constrained Sub-types panel meaning it 

was not possible to select/deselect certain sub-types. This has now been fixed. 
 

Additionally, in the new user interface, the Constrained tick box was no longer given 

a special colour to indicate when some sub-types are selected and others are not. Now 
fixed. 

Case 

• Case 48160 

An old model containing *CASE data, generated in an early version of PRIMER, 
crashed during Model Check in PRIMER 17. This was because Model check now 

checks output data fields and the logic which sorted case data for output contained 

some implicit assumptions about sub-case ordering to which this model did not 
adhere. 

 

Fixed in PRIMER 19.1 by making the sorting of sub-case permutations for output 
(PRIMER tries to organise these into ascending order) more rigorous which solves the 

problem. 

Checking 

• Case 49412 

Some tick boxes on the check → options → contact panel were not processing 

correctly. Now fixed. 

• Case 48651 

From R10 of Dyna it is acceptable to have multiple definitions of 
*CONTACT_INTERIOR keyword. The check function has been updated 

accordingly. 

• Case 48321 

Warning message for zero length discrete beams included SCOOR=3 which is a 

possible value. Updated and added warning messages for zero and non-zero length 

discrete beam for different SCOOR values. 

• Case 48162 
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Creating a new model, running model check, then writing xml file was crashing 
Primer. The logic for generating the filename has been made more robust. The 

workaround in older versions is to write the file out before checking. 

• Case 48131 

Fixed the issue with headers in the load profile panel which have a space in the name. 

• Case 47522 

Corrected the LS-DYNA version for which NPROC and FRSTP in 

*CONTROL_MPP_DECOMPOSITION_ARRANGE_PARTS are written out and 

added a warning if the fields are incorrect used. 

Connections 

• Case 49051 

When making NRB connection bolt onto solid rigid part that is coated with null shell, 

a spurious connectivity error appeared if the layer was defined with coating shell part 
rather than the solid part. Connectivity was however correct as nodes are shared by 

the solid and the shell part. 

• Case 48567 

Change of adhesive connection subtype is now blocked on the drop-down on 
connection table as it is not supported. 

• Case 48505 

If the spotweld create panel was exited in rivet mode, leaving that option set, 

subsequent adhesive creation attempts could fail. The switch to adhesives etc. on the 
main panel now resets the create option. 

• Case 48297 

Previously, when setting the Conx.path property via the JS API, PRIMER would 
crash if the property was initially zero. This has now been fixed. 

• Case 48230 

Create connection mode 'spotweld lines' does not support remesh weld logic. If a line 

weld was attempted when the remesh option was active from a previous scalar weld, 
the process could result in a crash. 

Fixed by switching off the remesh option when 'spotweld lines' mode is selected. 
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Constraints 

• Case 48191 

Previously when keyword files with *CONSTRAINED_NODAL_RIGID_BODY 
were read into PRIMER, the create editor was not updated to show _SPC, _INERTIA, 

_OVERRIDE options. It is now fixed.  

Contacts 

• Case 49367 

Model check of tied contact using set node could crash due to failure to increment a 
counter properly. Now fixed. 

• Case 48894 

CONTACT option AIRBAG_SINGLE_SURFACE now supports FS = -1 and FS = -2 

in the create/modify panel. 

Crash test setup 

• Case 49424 

For the Euro NCAP Side Impact load case, if the vehicle was pointing in negative x 

direction, the Offset distance was moving the barrier in the wrong direction. This has 
been fixed and the barrier will now move in the correct direction in respect to the R-

point. 

• Case 48667 

Batch Crash Test Setup Script used to crash when the user selected not to change the 
contact ID if it already existed. This has been fixed and the user can decline to change 

the created contact ID if promoted. 

• Case 48409 

Fixed a bug in the Crash test setup script that was preventing the list of unique items 
in the 'Filter by' buttons in the CRASH TEST tab to be updated for new user defined 

load cases. 
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Cut section 

• Case 49154 

The cut section direction tabs D1, D2 and D3 were overlapping buttons on the 'More 
drag options...' panel. Now they disappear correctly like other buttons from the main 

cut section panel when these options are opened. 

• Case 48364 

LS-dyna method of cut section definition in PRIMER did not work very well. It did 
not allow user to change the cut plane and instead returned messages of resetting the 

plane properties. This was caused due to incorrect calculations which now have been 

fixed. 

Database 

• Case 47492 

Database ASCII panel when dragged out of the PRIMER session, didn't have a 

graphics refresh event. It worked fine when the panel is inside the PRIEMR session. 
This is now fixed. It graphics refresh for the DATABASE_ASCII Panel also happens 

when the panel is outside the PRIMER window. 

Edit 

• Case 48156 

In *DEFINE_BOX_NODES_ADAPTIVE edit panel, the field PID was not handling 
large labels correctly. 

• Case 48085 

Corrected the description of NFLS and SFLS parameters for options 5, 7 and 10 for 

*CONTACT_AUTOMATIC_SURF_TO_SURF_TIEBREAK keyword. 

Encryption 

• Case 49331 

The encryption tool could fail if the Tools menu was in a collapsed state when 

running. This has now been fixed. 

• Case 48499 

Materials in the encryption process stopped working when converted to 

*MAT_ELASTIC. Materials will now convert correctly into *MAT_ELASTIC. 
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FMH 

• Case 48867 

Some FMVSS-201U calculations could previously fail if the rear seating reference 
point were left undefined. This has now been fixed. 

 

Additionally, driver orientation (LHS/RHS) checks could, on rare occasions, be 
carried out incorrectly resulting in some standard points being marked on the wrong 

side. This too has been fixed. 

Formula 

• Case 48372 

Formula input should work now on keyword editor as intended for open-ended rows 
of INITIAL keyword. 

Graphics 

• Case 49309 

Rotating the model while holding the left control key was redrawing the labels for 
initial velocity plot. This caused the text to become un-readable after few model 

rotations. This has been fixed now. 

• Case 48032 

Fixed autocentre (AC) for display of IGA_SHELL type part. 

IGA 

• Case 49519 

IGA refine panel could crash when entering higher degree value in PR or PS textbox. 

Now fixed. 

• Case 48212 

INITIAL_STRESS/STRAIN_SHELL/SOLID_NURBS_PATCH panels fixed to refer 
to correct entity. For the <eid> field should refer to 

SHELL/SOLID_NURBS_PATCH rather than standard shell/solids. 
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Include 

• Case 48906 

When the results of Model Modified are reported in an error tree, and include file 
membership is shown, then the name reported for the master file (include #0, acronym 

I0) could have been that of the last include file read. The same error could occur in 

other trees showing the master filename. 
 

Caused by an error in the keyword reader 'fuzzy logic' which deals with alternate 

filenames (eg .gz, .zip, etc). Now fixed. 

Include transform 

• Case 48322 

PRIMER was applying an INCLUDE_TRANSFORM label offset to a field that is 

zero. The field is a one referring to DEFINE_TRANSFORMATION, but this is set to 
zero so PRIMER should not be applying an offset to it. This has been fixed now by 

checking if the field is zero before being added to the offset. 

JavaScript API 

• Case 49447 

The KeywordCards method for the Material class would write empty lines for any 
optional lines in a material if they were not present in the model. Now fixed. 

• Case 48913 

The Window.keepOnTop property could not be set in the GUI Builder. This has been 

fixed. 

• Case 48675 

A PRIMER crash was caused by closing a running JavaScript window which was 

opened by a macro that stopped running due to a 'Macro Playback error'. This has 
been fixed, and users can close the open JavaScript windows after a 'Macro Playback 

error' as expected. 

• Case 48391 

A crash could happen when adding a 
CONTROL_MPP_DECOMPOSITION_TRANSFORMATION with the Javascript 

API. Now fixed. 
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• Case 47761 

JavaScript API Options.text_colour is now working correctly when the Primer Screen 
Text is set to 'Not bg'. 

• Case 46373 

Running a JavaScript that used Window.BuildGUIFromString() from another script 

using the RunScript() function would cause PRIMER to crash. 
 

Similarly, running two scripts that used Window.BuildGUIFromString() at the same 

time would also crash PRIMER. This has been fixed. 

Keyword 

• Case 48356 

*DEFINE_SPH_MESH_SURFACE was shown as SPH_MSH_GEN in the DEFINE 

keyword popup. Now it is shown as SPH_MESH_SURFACE. 

• Case 48035 

The keyword editor of *ELEMENT_SOLID_NURBS_PATCH was not getting closed 

when deleting the model. Now fixed. 

Labels 

• Case 48273 

Label from entity panel has been fixed for ELEM_SHELL_NURBS_PATCH and 
IGA_SHELL. 

• Case 48272 

Fixed the label tick box for INITIAL_LAG_MAPPING and 

INITIAL_HISTORY_NODE.  

Mass 

• Case 49523 

Models with *ELEMENT_MASS_PART_SET which use *SET_PART_COLLECT 

were not reporting the mass correctly, omitting the mass of the 
*ELEMENT_MASS_PART. Now fixed. 
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Materials 

• Case 49060 

Editing *MAT_GENERALIZED_DAMAGE keyword NFLOC fields previously did 
not update of NFLOC for each NHIS instance, assigning the same value to all 

instances. This has been fixed. 

Mechanism 

• Case 48654 

The assemblies’ names were incorrectly shown in the Child Dummies for 
Mechanisms panel. Fixed this. 

Menus 

• Case 47952 

Fixed object menu bug: 'Hover, scroll, click' being mistaken for 'press, drag, release' 

for object menus with no scroll bar. 

• Case 47810 

Previously, when saving a file on Linux, the file selector window would read 'Open' 

on the accept file button. This has now been fixed such that the button reads 'Save'. 

Merge 

• Case 48790 

For large models, the PRIMER was taking long to retrieve the clashing labels list 

while performing the Model Merge. Fixed this. 

• Case 46321 

Synchronized 'Merge _COLLECT sets' tick box in 'PROGRAM OPTIONS' and 
'Merge' panel. 

Mesh 

• Case 46347 

As shell splitting for multiple shell split case happens through centre only, the radio 

option is now set to 'Split at centre' option and the radio button box is greyed out. 
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Model modified 

• Case 48143 

When ImportInclude was used in a Javascript, subsequent use of include → find 
modified resulted in red-lighting of all includes which is not helpful. This has been 

corrected so that PRIMER red-lights only the imported include. 

Morphing 

• Case 44750 

Previously, if a morph point was selected in the morphing panel but then deleted it 
would still appear drawn in the graphics area. This has now been fixed such that 

deleted morph points are no longer drawn. 

• Case 44738 

Previously in PRIMER, after morphing a HAZ weld and then remesh that weld 
subsequent morphing operations could leave some of the new nodes from the remesh 

could get left behind. This has now been fixed. 

Orient 

• Case 49296 

Click on a node using Orient → Node Drag → Optimise was assigning wrong 

element quality to the element the node belonged to. This has been corrected. 

• Case 48537 

Previously, when clicking the 'All' button in an ambiguous pick menu when selecting 
nodes for a local coordinate system in the Orient → Node Drag panel, PRIMER 

would crash if there were more nodes in the ambiguous pick list than there were 

Nodes required to select. This could also occur during other similar situations with 
PRIMER. This has now been fixed such that PRIMER will now only select the first N 

items from the ambiguous pick menu when clicking the 'All' button, where N is the 
remaining number of items required to select. 

Parameter 

• Case 49171 

Some users exploit the fact that LS-DYNA does not read beyond the end of the 

formatted line (typically column 80 in small format) to add comments on the line 
itself. 
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When one of these comments contained a comma PRIMER treated the line as being in 

comma-separated format causing it to misread that card and possibly to reject the 

input deck. 
 

This has been fixed by changing PRIMER so that it only considers a comma to be 

relevant if it lies within the expected columns of data on the line, ignoring it if it is 
beyond this. The expected line limits for valid data are: 

 
Small format == 80 columns 

I10 format >= 80 columns (10I8 becomes 10I10 = 100 columns) 

Large format >= 160 columns (10I8 becomes 10I20 = 200 columns) 
 

Any data on the line beyond the expected line limit is lost. 

• Case 48155 

When TYPE (formerly IBQ) on *CONTROL_BULK_VISCOSITY was a parameter 
of value -2 the parameter got lost and -2 was written out. Now fixed. 

Pedestrian 

• Case 49429 

Fixed an issue where the pedestrian run builder tool could crash. 

• Case 49077 

Previously, the pedestrian markup tool would crash if the 'Write elements to keyfiles' 

option was selected when running the markup for EuroNCAP Testing Protocol v9.0. 

This has now been fixed 

• Case 49072 

Previously, the pedestrian markup tool could crash when calculating head impact 

points on or close to the side reference line. This has now been fixed 

Penetrations 

• Case 48779 

Previously, after selecting nodes to move via the 'pick and propagate' option in the 

Contact Penetration Checker tool, PRIMER would then fail to move those nodes via 

the different fixing options (e.g. autofix). This has now been fixed. 
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Program crash 

• Case 48989 

When speeding up V19 an error was made in the processing of individual layer 
thicknesses from *INTEGRATION_SHELL data as referenced on the 

*SECTION_SHELL card. This could result in a crash when plotting shells in true 

thickness mode. Now fixed. 

• Case 48865 

Models with latent nodes and complex sets (SET_GENERATE, SET_GENERAL,etc) 

could give a crash in internal set handling. Now fixed. 

Quick pick 

• Case 49324 

The PP button in the graphics bar no longer maps the red X underneath when toggled 
from off to on. 

• Case 49173 

A bug which caused a gap between buttons in the Quick Pick action drop-down menu 
for SET_PART to SET_TSHELL types has been fixed. 

Read 

• Case 49456 

All IGA keywords which contain WGT field (IGA_1D_NURBS_XYZ, 

IGA_1D_NURBS_UVW, IGA_2D_NURBS_UVW, IGA_2D_NURBS_XYZ, 
IGA_3D_NURBS_XYZ) are updated now. Blank WGT field should read as 1.0 in 

v19.1. In v20 user will be able to read and write blank WGT field as blank field. 

• Case 49097 

When reading *ELEMENT_SHELL_DOF the keyword reader could lock up due to 
internal conflicts in the parallelised reading of both the conventional nodes and the 

scalar nodes implicit on this card. 
 

The problem has been solved by turning off parallelised node lookup when a data card 

also has scalar nodes, that is suffix _DOF on SHELL and SOLID, also suffices 
_ELBOW and _WARPAGE on BEAM. 
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• Case 49048 

When reading a model with skipped data directly into an existing model with skipped 
data, a crash could result. The file handling logic has been made more robust. 

• Case 48519 

If an include file contained one or more blank lines before the initial *keyword then it 

would cause a read error. However, the file would read OK if read in isolation. 
 

Caused by an error in the way potential multiple include filenames were handled after 

the initial *INCLUDE statement in the parent file. Now fixed. 

• Case 48386 

Parameters used in *AIRBAG_PARTICLE cards starting with + can now be read by 

PRIMER 

• Case 45955 

RBE2s were not read from Nastran deck in PRIMER if they contained fewer than 2 

nodes. Fixed now. 

Scripting 

• Case 48261 

The 'Multi param' script could fail with an error: “ErrorTermination is not defined”. 
Now fixed. 

Text 

• Case 48566 

Previously, PRIMER would throw errors after using the text edit functionality to 

modify a keyword containing parameters while the Pre-read parameters option was 
set. This has now been fixed. 

Translators 

• Case 49230 

PRIMER crashed while trying to read in ABAQUS models containing *CONTACT 
PAIR cards but no *SURFACE definitions. This has now been fixed. 
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Units 

• Case 48255 

Corrected the units of fields in certain *MAT keywords: 

*MAT_OGDEN_RUBBER 

*MAT_SOFT_TISSUE 

*MAT_HEART_TISSUE 
*MAT_LUNG_TISSUE 

*MAT_HILL_FOAM 

User interface 

• Case 49370 

Updated UI to JavaScript warning popup panles. 

• Case 49249 

The ICFD_DATABSE keywords were picking up abbreviations from a wrong place. 

Also the keyword ICFD_DATABASE_UINDEX was not being shown in the in the 
list as the number of pop up entries was not right. Both have been corrected now. 

• Case 48378 

When a *DEFINE_CURVE or *DEFINE_TABLE editor was launched from another 

*DEFINE_CURVE or *DEFINE_TABLE editor (e.g. 
DEFINE_CURVE_DUPLICATE or DEFINE_TABLE_3D), the panel title always 

referred to the wrong parent keyword. This has now been corrected. 

• Case 46436 

Latent nodes did not get cyan background in textboxes of create panel for 
*CONSTRAINED_JOINT. Now fixed. 

• Case 46431 

Object menu in project tab of the orient panel was previously not immediately 
available. It was only available after switching the tabs. 

Now, it is available directly in the project tab of the orient panel. 
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Write 

• Case 49271 

When a *DEFINE_TRANSFORMATION card uses the POS6N option it is important 
that the 6 nodes in question are written out beforehand, so PRIMER writes a special 

'out of normal order' block of 6 *NODE cards. 

 
When these node labels were too wide for the prevailing keyword format (eg > 

99,999,999 for small format) an option to auto-promote the keyword to I10 format 

using a '%' suffix failed to work correctly. 
 

This was because the out-of-order *NODE cards were written using a special routine 
which failed to run some internal format checks. This has now been corrected and the 

cards will be auto-promoted if required. 

• Case 49205 

When a deck contains labels outside the small keyword format limit (typically > 
99,999,999) PRIMER will offer to write the file in I10 or LONG formats. 

 

I10 format works but it can cause problems in LS-DYNA when the intermediate 
structured deck created by the keyword reader to format input for LS-DYNA's solver 

continues to use small format. To get round this it is necessary to add 
 

'long=s' 

 
to the *KEYWORD line to tell LS-DYNA to use a long format structured deck. 

 
Therefore PRIMER now adds 'long=s' to the *KEYWORD line in the following 

situations: 

 
(1) The original input deck had 'long=s'. (Unless the model is now being written in 

long format in which case 'long=y' will be used.) 

 
(2) The model contains labels > 99,999,999. Generally, PRIMER will also write such 

decks in I10 format so the *KEYWORD line will contain 
 

'i10=y long=s' 

 
(3) The preference primer*long_structured_deck is set to ALWAYS 

 

 
That preference defaults to AUTO giving the behaviour in (1) and (2) above. It can be 

set to NEVER to turn this off altogether. 
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• Case 48861 

PRIMER could previously crash while writing out ABAQUS decks after reading in 
LS-DYNA models containing certain entity titles. This issue has now been fixed. 
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2.2 D3PLOT 

2.2.1 Bugs fixed in 19.0 

Animation 

• Case 33456 

Removed MPEG-1 movie capture functionality from D3PLOT. 

Attached 

• Case 47694 

On completion of a recursive Attached operation, the ‘Recursive’ option is now 

automatically switched off. 

Blanking 

• Case 46183 

In the Propagate Properties popup menu, user can now select both the model and the 
window from which to propagate properties. This is important for blanking, which is 

stored on a per-window basis. Previously if an entity was blanked in any window, it 

would be propagated as blanked. Now it will only be propagated as blanked if it is 
blanked in the selected window. 

Blanking options have also been added to the Export Menu, Window Options popup 
and the Quick Pick popup accessible by right-clicking on a model. 

Contour 

• Case 47058 

Integrated beams no longer reset to integration point 1 when the component is 

changed. The default has also been changed from integration point 1 to Mag All. 

• Case 46787 

If multiple models were loaded into a Window, it was sometimes possible for a data 

component to be shown as ‘Not Computed’, even when it should have been available 

for one of the models. Now fixed. 
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Cut section 

• Case 47903 

Fixed a crash that could occur when predictive screen picking while cut sections were 
used with two models of different sizes in the same window. 

• Case 47631 

In Volume III analysis, sometimes the number of nodes and elements increases in 

later states as the mesh is refined. When viewing a state containing more nodes and 
elements, a crash could occur during screen picking operations. Now fixed. 

• Case 47321 

Cut section thicknesses were sometimes offset in the wrong direction with NLOC. 

This happened on elements whose first node was on the positive side of the cut plane, 
but worked correctly when the first node was on the negative side. Now the offset is 

applied correctly in both cases. 

• Case 47120 

Fixed an issue where the wrong cut plane position was used when cut section 

definitions were changed with the JavaScript API function SetCutSection and then the 

intersection of elements was calculated with GetCutCoords. 

D3PLOT Viewer 

• Case 47832 

When exporting an animated contoured model to GLB for D3PLOT Viewer, 

D3PLOT switches to the safer ‘scan every state’ mode to ensure the contour bar 

shows the correct max and min values for the full animation. If D3PLOT wasn’t 
already in this mode when export began, it will switch back once the export is 

complete. A message to the dialogue box was missing when this happened, to make it 
consistent with Movie output, so this has now been implemented. 

Data components 

• Case 47074 

Fixed a crash that could occur when plotting a stress-based data component if an OP2 

file was read that did not contain stresses for all elements. 
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Dialogue command 

• Case 47878 

The dialogue command for setting the colour of an entity ‘/PROPERTIES COLOUR’ 
didn't work if the colour was LIGHT_GREY. Now fixed. 

Filtering 

• Case 47858 

If the file filter was set to ‘D3ATV Files’ in the Open Model menu and a folder 

contained both a d3atv and d3atv.ptf file, then the file selector would select both files 
when the d3atv file was selected. This only happened on Unix operating systems and 

has now been fixed. 

Graphics 

• Case 47943 

If different data components were plotted in a session and then within the same 
session the model was re-read, then in some cases if the same data components were 

plotted again some elements could disappear from the plot. Now fixed. 

• Case 47847 

Fixed a bug where, when using limiting values, choosing an action for Excluded of 

Outline or Draw in hidden colour after selecting Omit, and then hovering over the 

graphics window before pressing CT to update the plot, could cause only parts with 
visible data values to be shown in Outline/Hidden Colour (with the rest omitted). 

Groups 

• Case 48023 

When the predictive picking mode is set to Groups, trying to dynamically rotate a 

model with lots of groups is slow and could cause D3PLOT to freeze. This has now 
been resolved. 

Image 

• Case 47652 

In previous versions of D3PLOT, if the program was started with the ‘-batch’ option 
then hardware shaders were switched off. 
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Now, the default behaviour has changed and hardware shaders are now used by 
default in batch mode. 

 

A new preference has also been added that can be used to change the default 
behaviour if required: 

 

d3plot*batch_mode_use_shaders 
 

This can be set to TRUE (default) or FALSE. 

Integration 

• Case 47677 

Fixed an issue where the sync options in D3PLOT were automatically being refreshed 

to enabled (tick boxes checked) when a PRIMER link was created. 

• Case 47381 

When D3PLOT was linked to REPORTER, if you pressed the Resize button on W1 
and then right-clicked the Capture button on W2, and selected an output type, the 

wrong window (W1) would be captured. Now fixed. 

• Case 47272 

Fixed various issues associated with the synchronisation of model properties shared 
between linked PRIMER and D3PLOT sessions. 

JavaScript API 

• Case 47199 

The JavaScript API function GetCutCoords returned incorrect coordinates when a cut 
section had been defined in deformed space and the function was called with a 

state_id argument different from the state selected interactively. Now fixed. 

• Case 47186 

Fixed a crash that could occur if GetData or GetMultipleData were used to extract 
Solid Extra (SOX) or Shell Extra (SHX) data without specifying the ‘extra’ argument. 

• Case 46660 

Fixed an issue where the JavaScript API function GetCutSection could incorrectly 
return a previously used node instead of an origin coordinate in nodes[0]. 
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• Case 45911 

The ability to get the program version was added to D3PLOT and T/HIS, and the 
script failure_plot.js included with D3PLOT has been updated to load the PRIMER 

executable automatically. 

• Case 45789 

Documentation has been added for Utils class for D3PLOT. 

Materials 

• Case 47535 

Support has been added for *MAT_280 (*MAT_GLASS) extra history variables 

(additional material properties added to d3plot_library/matprop/mat_prop.csv). 

Measure 

• Case 47630 

If a node or point was selected for a measurement and then the shift button was 
pressed to rotate/translate the model, the picking mode reverted to quick pick rather 

than to the measurement picking. Now fixed. 

• Case 47097 

The Measure constructor caused crashes when called with invalid combinations of 

models and windows. Now it shows a more meaningful error message saying what 

has gone wrong. 

Memory 

• Case 48105 

Fixed a crash that could occur if a model was loaded that included *LOAD card 

definitions (read from the ZTF file) and the system was very low on memory. 

• Case 47861 

The virtual memory consumption bar in the Memory panel in D3PLOT now shows a 
sensible measure of total virtual memory consumption on the system. The original 

coding was out of date and did not show useful information on Windows 10. 
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Menus 

• Case 47986 

Fixed some refresh issues in the Colour menu that could occur if you had multiple 
windows open. 

• Case 47622 

Improved animation performance while the Measure panel is open by now only 

updating the measurement values displayed when the animation frame rate is 10 fps or 
lower. 

Movies 

• Case 47605 

Support for MPEG is now deprecated. MP4 is recommended instead. 

Program crash 

• Case 47649 

Fixed a crash that could occur when trying to select a point in an FLD Plot graph 
before the FLD Plot button had been pressed. 

Properties 

• Case 47730 

Fixed a bug where the Overwrite, New File and Help buttons were not being hidden 
after clicking New File when a file with the same name already existed. 

Read 

• Case 47944 

The default value for the file_skip was changed from 5 to 50. 

• Case 47291 

Fixe a crash that could occur when using the -ml=filename command line with certain 
model list files. In general an integer can be added at the end of each line with a 

filename to say which window(s) the model appears in. The meaning of that integer is 

bitwise, with 1 for window 1, 2 for window 2, 4 for window 3, 8 for window 4 etc. 
The crash in D3PLOT happened when that integer after the filename was 7. Now the 

model is correctly read into windows 1, 2 and 3. 
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• Case 47170 

If multiple models were opened and a beam integrated component was plotted with 
the integration point set to max, min, mag or ave, and then a model was closed, 

D3PLOT could crash. This has been fixed. 

• Case 46952 

A new preference has been added that allows you to set the value of file skip. This is 
in addition to the existing FILE_SKIP environment variable. The environment 

variable takes precedence. Example of its usage: 

 
d3plot*file_skip: 10 

 
This sets the file skip value to 10. 

Selection 

• Case 47857 

It is now possible to quick-pick internal solid elements exposed by a cut section. 

• Case 41951 

The logic used to pick items via Quick Pick or from within most menus has been re-
written so that it now uses the same logic and code as the Object menus used in 

Blank, Write, XY-Data. 

T/HIS link 

• Case 47883 

On Linux, when trying to open the D3PLOT-T/HIS link while a JavaScript Window 
was active, the T/HIS Dialogue window and Graphs did not get properly positioned 

on the screen. Now fixed. 

Template files 

• Case 47932 

If a user-defined colour was used to set the model colour in Window → Edit and a 

template file was saved, the file would write incorrect data. Now fixed. 
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User interface 

• Case 47931 

The colour palette window could close before you had a chance to edit a user-defined 
colour if you didn’t move your mouse over the window quickly enough. Now fixed. 

• Case 47481 

Error messages written to the D3PLOT and T/HIS dialogue windows are now printed 

in full, consistent with PRIMER. 

• Case 47231 

Fixed a menu refresh issue with the overlay colour button in the Display Options 

panel. 

Utilities 

• Case 47344 

Fixed a crash that could occur when screen-picking a part or elements for the die 
closure workpiece. 

Variables 

• Case 47840 

When capturing a D3PLOT object with variables from a multi-model session to 
REPORTER using the pre-v17 method, you could see an error message ‘In 

<d3_set_current_window> window_num 0 invalid’. Now fixed. 

XY plot 

• Case 46926 

Fixed a bug where ‘Export ALL to XY_PLOT’ caused the program to hang and 
display an error message. 

ZTF 

• Case 47394 

LS-DYNA allows beam spotwelds using *MAT_SPOTWELD to be converted 

automatically to solids by setting the RPBHX flag on 
*CONTROL_SPOTWELD_BEAM. With this flag set, LS-DYNA deletes the beams 

from the model and replaces them with solids. 
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D3PLOT can display these spotwelds if a ZTF file is present, but to do so it has to 

work out from the beam information in the original keyword input file which solid 

elements (which are not present in the input) will actually be created by LS-DYNA. 
 

This was being done incorrectly, with the result in most cases that the spotwelds were 

simply not shown. However if the option to display spotwelds using the underlying 
solid elements was switched on, D3PLOT could crash. 

 
This has been fixed and these spotwelds now display correctly both as spheres (the 

default display mode) and as the underlying elements if that display method is chosen 

instead. 
 

In addition, if a beam set BMSID on *CONTROL_SPOTWELD_BEAM was used to 

restrict the conversion of spotweld beams to only a subset of beams, this too was not 
working properly and could cause a crash. This has also been fixed. 
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2.2.2 Bugs fixed in 19.1 

Airbag 

• Case 48468 

Airbag particle (CPM) data such as pressure and velocity can be 'mapped' onto a 
cellular grid in order to aggregate data within a finite volume, i.e. per cell of the grid. 

In some cases it makes sense to 'smooth' these results further over adjacent cells and 

this smoothing process was introducing a geometric shift in the results. In effect when 
smoothing over N adjacent cells the contributions from -N but only +(N-1) cells were 

being used, shifting the result in the -ve X/Y/Z directions. In addition contributions 

from completely empty cells were being added to the smoothed average result which 
could cause a bias near the boundary of an airbag volume. 

 
Now fixed by making the smoothing process symmetrical, also ignoring the effect of 

adjacent empty cells. 

Animation 

• Case 47011 

If, whilst capturing animations for REPORTER, the user had specified a custom state 
selection from the Images/Media Export panel, the Animation Control box could 

appear to be dismissed during the capture process on Linux only. In fact, the panel 

was not dismissed, just obscured by the graphics window during the capture process. 
Graphics windows are now lowered again after the capture is complete to alleviate 

this issue. 

Contour 

• Case 49107 

If a Thick Shell was contoured and one of the through thickness (element local Z 

direction) faces was drawn as a constant colour because all of the values on that face 

were in the same contour band then the colour of that face could be wrong. 
 

This problem never occurred with the top and bottom surfaces. This is now fixed. 

• Case 48695 

With multi-threading and shift deform, user-defined components for shells or solids 

could give inconsistent results when the shift deform was turned on and off. This has 

been fixed. 
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• Case 48147 

Cloud plots averaged at nodes and with some solid or thick shell elements blanked 
would plot blobs at nodes that were not on any unblanked element. This has been 

corrected. 

• Case 48132 

Plastic strain tensor components for the bottom integration point were plotted 
identical to those for the top. This has now been fixed. 

• Case 47095 

D3PLOT contours both integrated and resultant beams with components selected 

from either Beam integrated or Beam resultant categories in the components menu, 
because it is not possible to identify which type the beam elements are. The user must 

exercise caution in correctly interpreting the resulting plots. A warning has been 
added to give details, along with a preference - show_beam_component_warning: 

TRUE/FALSE that can be set to FALSE to prevent the warning box appearing. 

Cut section 

• Case 49155 

The cut section direction tabs D1, D2 and D3 were overlapping buttons on the 
'Options & Tuning...' panel. Now they disappear correctly like other buttons from the 

main cut section panel when these options are opened. 

• Case 48895 

If the 'per-state' option is ticked in the true thickness capping of shell settings, in cut-
section panel, although the cutting switch is OFF, if the new model is read in, the 

cutting switch turns ON automatically. 
 

Fixed this issue. 

• Case 46674 

If a cut-section was dragged interactively while a velocity plot was being displayed 
then in some circumstances the velocity arrows on nodes that were no-longer on the 

visible side of the cutting plane were still displayed until something else forces the 
screen to redraw. 

 

This problem only occurred if one side of the plane was being drawn as normal and 
the other side was being omitted and the option to update contour bars while dragging 

wasn't turned on. This has been fixed. 
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• Case 45550 

Cut section forces and moments were output as zero when multiple parallel cuts were 
switched on. Now the forces and moments are calculated correctly and displayed for 

the central cut plane, i.e. the plane at the cut origin. 

Database 

• Case 48578 

The -mdb command line option was not opening the 'open file' menu in D3PLOT with 
the 'select models from database' option selected. This has been fixed. 

Dialogue command 

• Case 48648 

The dialogue command '/BLANK SOLID AV' should blank all the visible solids, but 

it was only blanking the outer layer in a block of solids and not the internal ones. This 
has been fixed. 

• Case 48577 

Typing the dialogue commands: 
 

/BLANK SHELL ALL 

/UNBLANK ALL 
/BLANK BEAM ALL 

 

Should have resulted in just the beam elements being blanked, however D3PLOT was 
blanking both the shell and beam elements. 

 
This has been fixed. 

• Case 48463 

Support added for EXPORT_3D_UNCOMPRESSED dialogue command to export 

uncompressed GLB files. 

Envelope 

• Case 48726 

When plotting envelope data if the calculation is stopped partway through before all 

states have been scanned the envelope is switched off. If enveloping is then switched 
back on the previously calculated partial envelope may be displayed rather than the 
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remaining states being scanned to complete the envelope calculation. This has been 
fixed. 

• Case 48723 

Opening new window with enveloping switched on could cause a crash in D3PLOT. 

This has been fixed. 

• Case 47459 

A bug where reading in a new model when enveloping was on in any window would 

cause the menu to indicate that enveloping was off even though the graphics still 

showed it as on was fixed. Now the enveloping menu reflects the graphics window 
with it being turned off. 

Femzip 

• Case 49118 

Version 19.1 of D3PLOT now supports reading a FEMZIP compressed INTFOR 
(CTF) file as a standalone file. 

 

If the user has compressed both the PTF (d3plot) file and the INTFOR (ctf) file then 
D3PLOT can not open both files as s single model. 

Filename 

• Case 48776 

Previously if the user read a model into D3PLOT where the filename contained 

multiple "." then the default filenames for saving properties files were wrong. This has 
now been fixed. 

Graphics 

• Case 48157 

If in D3PLOT or T/HIS, the advanced page layout was being used and items were 
being reordered by dragging them around interactively, an item could disappear from 

a page if the 'swap items' option had been selected and items were swapped multiple 

times. 
 

Swapping back to 'basic' mode and re-selecting the page layout would re-display the 
missing item on the page again. This is now fixed. 
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• Case 47951 

If in D3PLOT the user pressed a mouse button and started to move the mouse before 
they had pressed one of the dynamic viewing keys, then D3PLOT would start to drag 

out an area for selection before it detected the keypress and swapped into dynamic 

viewing. At the end of the dynamic viewing operation D3PLOT would remember the 
area that had been dragged across before the keypress and could continue to display a 

grey rectangular border surrounding the area within the graphics window. 

 
This has been fixed. 

• Case 47395 

In D3PLOT 19.0, a model would sometimes start to display the full mesh on top of 
parts even when 'free edge' was selected if a combination of transparency and 

displaying shell parts with thickness was used. This didn't always happen and would 

occur randomly on models. This has been fixed. 

• Case 44593 

Fixed a couple of problems with transparent rendering of beam elements: 

 

(1) If a beam was made wholly (100%) transparent then its overlay in the default 
'beams drawn as lines' mode on shaded plots would switch back to fully opaque lines.    

 
(2) If a beam is drawn in 'true section' mode then, depending on the section type, it is 

likely to have some sort of faceted section shape drawn in shaded plots.   When 

transparency was turned on this did not change until something else caused the plot to 
be updated, whereupon it would then be drawn correctly. 

Groups 

• Case 49232 

 
When two or more D3PLOT executables accessed the same group file (.grp) in the 

same directory they clashed, resulting in extremely slow processing. 

 
A preference has been created to fix this: d3plot*delete_group_file can be set to 

TRUE meaning that a process will delete its group file when it exits, effectively 

treating it as transient. 
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Image 

• Case 48116 

If while using the view matching function to align a model with a background image 
the user pressed the middle mouse button to undo the last node or point they had 

selected the following message was generated 

 
Cursor list is empty : R(eject last) is invalid. 

 

This has been fixed in D3PLOT 19.1 and using middle mouse to undo the last 
selection now works. 

• Case 46031 

When an image filename contained more than one '.', D3PLOT did not write out the 
file correctly. This has been fixed. 

Integration 

• Case 44083 

In cases where the D3PLOT-PRIMER link has yet to be initialized, various PRIMER 

link actions would not just start PRIMER for you. It would require  to manually start 
the link and then issue the action. 

 

For options in the 'WRITE' menu and when right clicking on various 
Parts/Nodes/Shells of the model, these should now bring you straight into the 

PRIMER session automatically so long as D3PLOT can find a valid keyword file. 
Otherwise, it will prompt you to find one to be able to open the link and continue. 

JavaScript API 

• Case 49435 

The JS API function GetNumberOf could crash when no model was open in 

D3PLOT. For types specific to a model there is now an exception saying that no 
model is open. For types not requiring a model a value is now returned as expected, 

for example GetNumberOf(WINDOW) and GetNumberOf(MODEL) now return 0 
without exception when there is no model open. 

 

Also the function SetCurrentModel was crashing when there was no model open, 
where now it reports an exception. 
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• Case 49065 

 
When calling GetNumberOf() function in JavaScript before reading in a model, 

D3PLOT searches for a model. If no model is present it crashes, even when a model is 

read in the script before calling the function. 
 

This has been fixed, however if the user tried to call any related function in JavaScript 

without reading models, this will cause D3PLOT to crash. 

• Case 47390 

Using the DeleteWindow() function would cause D3PLOT to crash if it deleted the 

last window. This has now been fixed. 

Local axes 

• Case 48357 

If a model contained Discrete beams then the local axis system of the beam was 

displayed incorrectly if the *SECTION card referenced a Coordinate System. Now 

fixed. 

Movies 

• Case 47995 

Added support for d3plot*movie_format and d3plot*glb_format preferences. 

Part tree 

• Case 49400 

When there was no model open in D3PLOT, the Select... button on the part tree 

crashed D3PLOT. Now it no longer crashes, but it does nothing because there is 
nothing to select from without any model. 

Program crash 

• Case 49254 

If a window was closed and the option was selected to leave the model in the 
database, writing out a properties file for that model (in the utilities->settings file) 

would cause D3PLOT to crash. This has been fixed. 
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Program hanging 

• Case 49079 

Fixed the issue that caused D3PLOT to hang after question about mid-surface. 
Hanged when tried to SI plotting data component EXTRA with Averaging ‘OFF’ and 

Surface ‘Max All’ 

Properties 

• Case 47532 

Fixed a bug where the Export button in the properties menu was not being hidden and 
was obstructing the Apply button after it was clicked. 

Ptf compress 

• Case 49094 

The PTF files written out in the original (default) format from D3PLOT using the PTF 

Compress menu didn’t always read into Altair Hyperview correctly but did read into 
D3PLOT, LS-PrePost and Animator 4. Now fixed. 

Quick pick 

• Case 48345 

Previously in D3PLOT it was not possible to screen pick seatbelt and spring parts if 
the LS-DYNA analysis had been run with the option to automatically create beams on 

top of these parts was used and the display of beams was then turned off in D3PLOT. 

\This has been fixed in D3PLOT 19.1 

Read 

• Case 49179 

On some Windows computers where remote files are hosted on Linux systems and 

exported via a SAMBA server we have seen problems of files being locked 

unnecessarily when opened for reading. A typical scenario is: 
 

+ User submits an LS-DYNA job on a remote system. 
+ User opens results file for viewing in D3PLOT or T/HIS while the job is still 

running. 

+ Later on user reopens the results file on the same machine to check progress and 
finds that no more results appear to have been written. 
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+ However opening the file on a different machine shows that further results have in 
fact been written. 

 

To solve this, D3PLOT and T/HIS have been fixed to allow normal updates to occur 
so the files are not locked unnecessarily. 

• Case 48878 

When cut sections were turned on in a model with true element capping, thicknesses 

per state and then another model was opened, D3PLOT crashed. This has now been 
fixed. 

• Case 48590 

Fixed a bug involving the following issues: 
 

If contact surfaces were blanked via the Part Tree then the wrong items were 

blanked/unblanked. 
 

If Quick Pick was used, then the key-in option did not work for Contact surfaces. 

 
If the ‘Only’ option was used to display a Contact Surface then the Undo (middle 

mouse) did not restore the items previously visible correctly. 

Scripting 

• Case 49246 

The create_webgl and Swforc scripts crashed D3PLOT when they were clicked on the 

script tree in the JavaScript tool without any models being loaded. Now they report 

error messages saying that no model is open. 

Settings file 

• Case 48224 

A bug where reading in an invalid results file in D3PLOT and then opening a valid 

results file in any way other than ‘Single Model’ mode would crash D3PLOT was 
fixed. 
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Sketch 

• Case 48992 

D3PLOT was crashing when sketching an entity in a linked PRIMER session for 
which sketching was not supported in D3PLOT. This was due to an overflow in the 

D3PLOT error message. Now fixed. 

T/his link 

• Case 49216 

Fixed issue where T/HIS window when opened in D3PLOT was not showing as 
CHILD window when preference is set to CHILD. 

User interface 

• Case 49441 

Fixed a bug in both D3PLOT and T/HIS where some graphics windows could be 

positioned automatically so that they incorrectly overlapped. This occurred when the 
Advanced Page Layout options were used while items were manually added to a page 

after the layout for that page had been set to 2x2 or 3x3. 

• Case 48276 

The slider at the top of a graphics window should update the current animation frame 

immediately when it is dragged, but this was broken in D3PLOT 19.0 meaning that 

the frame only updated when you released the mouse button at the end of a drag. Now 
fixed. 

WebGL 

• Case 48453 

When outputting a glb file via the command line the contour bar values for animated 

output could be incorrect if the last state did not contain the max/min values for the 
whole analysis. This has been fixed. 

• Case 46784 

GLB export options are now saved in the settings file. 
 



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 19.1 

 

Ove Arup and Partners Limited | Final | October 2022  

 

Page 60 
 

Write 

• Case 49157 

Clarified functions in the Write -> Keyword data panel: 
 

- To clarify what the 'Include Deleted Elements' option does: 

  > Moved 'Include Deleted Elements' to above 'Initial Stresses' & rephrased it to 
'Include Deleted Elements for Stress & Strain' for clarity 

 

- Additional improvement to panel: 
  > Updated panel to grey out sub-options of 'Nodal coordinates' & 'Elements 

topology' when they are not ticked 

• Case 48785 

Write Panel in D3PLOT was not producing the correct file and its format when 

saving. Fixed that issue to get the right file type when saving entities, Model 

Summaries and scans. Also, D3PLOT was not outputting xlsx files as they weren't 
closing properly. Fixed that as well. 

XY plot 

• Case 48975 

Changed the write format in XY Data in D3PLOT such that the factor before the 

exponential (before decimal) is between 1.0 and 10.0 

Ztf 

• Case 49460 

When a cutdown PTF file was created from a model which contained 

*DATABASE_XSEC shells but the cutdown PTF file itself did not contain those 
shells, and that cutdown PTF file was saved within the same directory as the original 

model's ZTF file then D3PLOT would crash as it attempted to link against the ZTF 

file. This has now been fixed. 
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2.3 T/HIS 

2.3.1 Bugs fixed in 19.0 

FAST-TCF 

• Case 47658 

When reloading a T/HIS item from REPORTER into D3PLOT, if there was no active 
linked T/HIS session, D3PLOT would display an error message ‘Playback 

('command') file not found’. This has now been fixed. 

Help 

• Case 47541 

Added Help text for WIF operation. 

Integration 

• Case 47383 

T/HIS items defined as fixed size in REPORTER were not resized correctly in 

interactive mode and when generating. Now graphs in T/HIS are resized correctly. If 

the specified size is greater than the available resolution, the specified size is treated 
as an aspect ratio and the size of the graph is maximised within the available 

resolution. 

JavaScript API 

• Case 47368 

If a JavaScript was run in T/HIS that created a GUI and restricted input using the 

modal option, then if a Curve.Pick() or Curve.Select() operation was started it wasn’t 

possible to select a curve in the Graph on the first attempt. Now fixed. 

• Case 47326 

PRIMER, D3PLOT and T/HIS could crash if a script that used a GUI created with the 

GUI Builder was run in the debugger. Now fixed. 

• Case 47149 

Running a JavaScript that had a GUI created from the GUI Builder would write an 
error message (‘Cannot find script to remove from script stack’) to the dialogue box 

when the script finished. Now fixed. 
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• Case 45790 

JS API documentation added for Utils class for T/HIS. 

Macro 

• Case 47747 

T/HIS was not collecting correctly values with upper-case characters for some of the 

command line arguments. Now fixed. 

Operations 

• Case 47506 

When trying to stop FFT and IFFT operations over multiple curves, T/HIS would only 
stop for the curve that was currently being processed and would continue onto the 

next curve in the selection. Now, the entire operation is stopped. 

Pages 

• Case 46728 

Made corrections to the Page.Layout function to support “xy” layouts properly. 

Read 

• Case 45930 

Fixed an issue where some binout output branches (such as SECFORC) were not 

being read into T/HIS correctly because the internal directories (e.g. 
/secforc/d000001, /secforc/d000002, etc.) were not being incremented by one but by 

much larger values in some instances. 

Variables 

• Case 47984 

T/HIS items in REPORTER with variables defined in the FAST-TCF script could lose 
the variables when the items were generated. Now fixed. 
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2.3.2 Bugs fixed in 19.1 

Checking 

• Case 49224 

T/HIS crashed if you tried to open the File->Session menu from the Search tool. This 
has been fixed. 

Curve menu 

• Case 48398 

An UpdateCurveMenu() function has been added to the API to allow you to update 

the curve menu. This can be useful when a script generates a lot of curves as the curve 
menu will only update with the new curves when the script exits. Calling this function 

will update the menu. 

FAST-TCF 

• Case 48268 

In cases when a FastTCF script contains a 'reset1' command as well as a 'condense' 
command, some curves would not be correctly condensed. This is now fixed. 

JavaScript API 

• Case 48748 

Although the JavaScript functions DisableUpdate() and EnableUpdate() were 
implemented in T/HIS these functions never actually did anything.  They have been 

removed from the documentation in T/HIS 19.1 onwards but empty dummy function 

definitions have been left in case they had been implemented in any existing scripts. 

• Case 48149 

Fixed an issue in the JavaScript function Model.GetName(), where T/HIS would crash 

when using the function if the model contained a 

*DATABASE_HISTORY_{OPTION}_ID heading which was greater than 40 
characters in length. 

• Case 46940 

Setting the JavaScript property graph.active did not update the menus in T/HIS to 
show the status of a graph. This has been fixed. 
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LSDA (BINOUT) 

• Case 48534 

If extra time history variables were output for elements to the BINOUT file then 
T/HIS would fail to read and display any entity names that had been defined for the 

element (the entity ID's were read and displayed correctly). Now fixed. 

• Case 48527 

T/HIS could crash if a user tried to read extra time history variables for Thick Shell 
elements from the LSDA (binout) file. Now fixed. 

Menus 

• Case 43712 

Previously, the Write menu format Summary(CSV) caused T/HIS to incorrectly try to 

use the extension '.rep'. It now uses '.csv'. 
 

A directory button popup to access the recently accessed directories was also added to 
allow the user to jump from one directory to another while writing out files. 

Operations 

• Case 48267 

Depending on whether a SQRT operation was done via the 'Operate' menu or the 

'Maths' menu, the error handling for curves containing negative values was different. 
In both cases, it will now set y = 0 when attempting to square root a negative value as 

the message says. 

Pages 

• Case 49518 

When a FastTCF was created with an 'Advanced' page layout, the page selection 
buttons would not ungrey when that FastTCF was played back into T/HIS. This has 

been fixed. 

Program crash 

• Case 49428 

T/HIS could crash if a model was opened containing a BNDOUT ASCII file and the 

file only contained data from a single output interval. Now fixed. 
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Read 

• Case 48344 

T/HIS could incorrectly report that an LSDA (binout) file contained data for 1 
'curvout' entity when in fact the file did not contain any. 

 

If the user then tried to read the data, T/HIS could crash. Now fixed. 

Selection 

• Case 48397 

If a JavaScript used the function to Select curves then curves that were selected via 

the 'Key in' option were highlighted in the menu but when the 'Apply' button was 

pressed the curves were not actually selected. Now fixed. 

Session 

• Case 48984 

Fixed issue where the file path name in session files made on Windows could not be 

read in Linux systems and vice versa.. 

• Case 48692 

Fixed an issue where embedded T/HIS session files would not correctly read into 

T/HIS when trying to double-click the file or when the file was opened via the 

command line. 

T/HIS link 

• Case 41863 

The option to interactively pick joints in T/HIS when running the D3PLOT > T/HIS 

link has been removed in the Oasys Suite 19.1 as LS-DYNA can re-order and 

renumber joints if they have not been defined using the _ID option. This means the 
order and ID's of joints read from the BINOUT file can be different to those that 

PRIMER writes to the ZTF file as PRIMER uses the order the joints are defined in the 
input file. 
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User interface 

• Case 47396 

Fixed a bug where in a linked T/HIS in D3PLOT session, within the Title/Axes menus 
(e.g. for X-axis labels), pressing the tab key moved the cursor to the next textbox and 

highlighted the word. However when the user typed, the text was appended. 

• Case 46574 

When a string in a text button is longer than the space available for display, T/HIS 
shows only what can be displayed with 'bars' at the ends of the string where characters 

overflow. Dragging over text to select it in such situations requires the user to 

continue moving the mouse to the left or right outside the button in order to scroll the 
text left/right and pick up further characters. 

 
A bug occurred if such dragging caused the mouse to cross the boundary of the box 

containing the button the selection of text could go wrong: the whole string might be 

selected, or perhaps only the wrong subset of it. Now fixed. 
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2.4 REPORTER 

2.4.1 Bugs fixed in 19.0 

Animation 

• Case 45908 

When hovering over an animated Item with the Hand tool, forcing a page switch using 
Generate or switching to Design View using the ‘p’ shortcut would cause the hover 

controls to remain on screen unintentionally. Now fixed so that hover controls no 

longer persist. 

Edit 

• Case 47791 

Fixed an issue in which pre-existing D3PLOT and T/HIS items of Blank type were 

not being given a new default image filename when changing type. 

• Case 46932 

When converting an item from one type to another, it is now possible to preserve the 
item’s name. 

Image 

• Case 47780 

The default image name for a new T/HIS item is now incremented correctly 
to provide a unique name. 

Installation 

• Case 39730 

REPORTER now respects the OA_INSTALL_xx environment variable (taking 

precedence over OA_INSTALL environment variable, but not oasys*install_dir 
oa_pref option). 

Integration 

• Case 43178 

When an error occurs during report generation, or when a Script item calls 

Window.GetOptions, the Logfile or options window is now brought to the front of 
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your display (or the icon on the taskbar will flash, depending on what is permitted by 
your operating system). This helps notify you that action is required, especially when 

a PRIMER, D3PLOT or T/HIS session may have been launched in front of 

REPORTER, temporarily obscuring it. 

JavaScript API 

• Case 47338 

Previously, setting the font property of an Image item to a font family name that was 

not available in REPORTER would result in an exception being thrown. Now, the 

font name is mapped to the best available match in REPORTER. 

Manual 

• Case 45812 

Fixed a crash that occurred while launching the HTML manual through the Help 

menu on Unix systems. Updated code for launching HTML manual to work with a 
wider range of default browsers on Windows. 

Standard templates 

• Case 47962 

Corrected an issue with the head impact templates that meant that some items were 

not generated until after the report, PDF, HTML or PowerPoint had been written. 

• Case 47829 

Fixed some issues preventing the MPDB Compatibility Assessment templates from 

working with the LSTC MPDB model. You will still need to make modifications to 

the template scripts. See REPORTER → Help → Additional user guides → 
Euro_NCAP_MPDB_Compatibility_Assessment_REPORTER_Instructions.pdf for 

details. 

• Case 47813 

The MPDB Occupant Assessment templates now calculate Humanetics THOR 50M 

v1.8 chest deflection from the relative displacement between IR-TRACC nodes rather 

than from spring elongation. If you have already saved a CSV file with input 
parameters, you will need to update it to use the IR-TRACC nodes. 
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• Case 47188 

Fixed an issue preventing the MPDB Compatibility Assessment templates from 
working with a renumbered Arup Cellbond MPDB Shell Model. A renumbered 

barrier model should now work as long as a ZTF file is present alongside the results 

files. If you are unable to produce and use a ZTF file, you can use ‘Option 2’ in 
reporter_library/templates/scripts/MPDB/d3plot_MPDB_barrier_parts_blanking.js 

and enter the renumbered part IDs. 

• Case 44618 

The position of the barrier deformation plots in the MDPB Compatibility Assessment 
templates has been adjusted to reduce unwanted cropping. 

• Case 42836 

In many of the templates, the T/HIS graph legend text could become clipped if the 
labels were longer than the column width. This has been fixed by switching the 

legends from two columns to a single column. 

User interface 

• Case 43343 

Support for high-DPI displays has been improved. Text, icons, and widgets should 
now scale up in size appropriately when REPORTER is used with a high-DPI display. 

Windows Display scaling settings are respected for integer values. 
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2.4.2 Bugs fixed in 19.1 

Capture 

• Case 48664 

When updating an MP4 or GIF Capture for a D3PLOT Item, the Movie file path (for 

Generated output) was sometimes being accidentally replaced with a default path. 
This should no longer happen. 

• Case 47202 

In a REPORTER session linked to D3PLOT or T/HIS 19.0 and earlier, if the user 

resized an item in REPORTER by dragging the item box and then pressed Resize in 
D3PLOT or T/HIS, then the window/graph would be resized to the original 

REPORTER item size, not the dragged size. This has been fixed. 

Edit 

• Case 48958 

Fixed an issue where 'Unlocked' Items were being accidentally switched to 'Locked' 

without a request from the user. This could occur when using multiple selection to 

select a group containing both 'Locked' and 'Unlocked' Items. 

Integration 

• Case 49489 

When opening T/HIS from the 'Edit T/HIS object information' panel the specified job 

file would not be automatically read in if it contained spaces. This has been fixed. 

JavaScript API 

• Case 49337 

Corrected issues introduced to a number of Library Program scripts in 
REPORTER 19.0 that were preventing them from running. 

PDF 

• Case 43983 

REPORTER now supports Unicode text in PDF outlines (bookmarks) and the HTML 
index. This means that if the user includes Unicode characters in your REPORTER 

page titles, they will now appear correctly when the user writes a PDF or HTML file. 
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Pages 

• Case 48222 

Modified the behaviour of Oasys items on copy and paste, such that the new 'pasted' 
item is assigned a unique default filename in the 'Image file' field. Previously, the 

filename would be identical to that of the 'copied' item. This would result in the two 

items writing to the same location on Generate, which is very rarely intended. 

Pedestrian 

• Case 49443 

Updated the GTR Template to pass/fail based on the regulation that was missed that 

in case a point has hic value higher than 1700, it should show fail as the final output. 

• Case 49401 

For both the ENCAP Head Impact 2023 template and CNCAP Head Impact 2021 
template, the normalised score on page 2 of the template was not correctly displayed. 

Now fixed. 

Standard templates 

• Case 49192 

Fixed various issues in the Euro NCAP Far Side Impact 2022 template relating to 

chest and abdomen lateral compression calculations, and neck lateral flexion and 

extension calculations, for the WorldSID dummy. 

• Case 48336 

Fixed an issue with the MPDB Compatibility Assessment templates that could prevent 

any edits to d3plot_MPDB_barrier_parts_blanking.js from taking effect. 

• Case 48124 

Fixed a problem in T/HIS (see bug 48149) that could prevent various REPORTER 
templates (including MPDB Compatibility and Occupant Assessment templates) from 

generating successfully on a model containing 
*DATABASE_HISTORY_{OPTION}_ID keywords with titles greater than 40 

characters in length. 
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Template files 

• Case 49352 

Automotive library templates occupant entity ID selection in PRIMER: fixed a couple 
of issues causing the Pick and Select buttons to overlap other buttons in the 

*DATABASE_HISTORY popups. 

User interface 

• Case 49364 

Custom user colours that have been removed from all user_colours.xml files will no 
longer incorrectly appear in the 'Select Color' panel in REPORTER. 

• Case 45735 

The 'Missing image' warning popup will now only be displayed once-per-template, 

listing all Image items for which an image could not be loaded. 
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2.5 SHELL 

2.5.1 Bugs fixed in 19.0 

Read 

• Case 47681 

Fixed a crash that could occur in PRIMER, D3PLOT and T/HIS if the Checkpoint 
directory mentioned in the Options panel was not available. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 19.1 

 

Ove Arup and Partners Limited | Final | October 2022  

 

Page 74 
 

2.5.2 Bugs fixed in 19.1 

Read 

• Case 47681 

Fixed a crash that could occur in PRIMER, D3PLOT and T/HIS if the Checkpoint 
directory mentioned in the Options panel was not available. 

Filename 
• Case 48979 

The MPI executable filename can sometimes not end with '.exe'. So we have removed 

the file-filter for '*.exe' when fetching the MPI executable file from within the LS-
DYNA submission panel. 

User interface 

• Case 49504 

Fixed the 'command-line-expressions' in the LS-DYNA Submission panel to show the 

default values. 
The 'Binary File Size' did not reset to default upon pressing 'Reset' button in the panel. 

Fixed this. 

• Case 49496 

The 'Write Checkpoint Files' option was inconsistent in its behaviour. Fixed this. 

• Case 49415 

In the REPORTER panel, adjusted the size of a few labels that were not visible 

completely on smaller screens or on Linux machines. 
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2.6 Oasys 

2.6.1 Bugs fixed in 19.0 

Installation 

• Case 43703 

The installation directory for the software could be set incorrectly if any of the 
executables were started using a relative command and the absolute path was found 

using the PATH environment variable. Now fixed. 

Preferences 

• Case 45460 

Historically, all Oasys LS-DYNA software had defaults to map the main window 
initially at ~70% of the screen size, but we shipped a default oa_pref file which 

overrode this to launch the software in a maximised window. 

 
From Oasys 19.0, the default is now to start maximised. Users wishing to revert to the 

initial smaller size will need to set the preference: 
 

<code>*maximise: false 

 
where <code> is one of PRIMER, D3PLOT etc. or OASYS for everything. 
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2.6.2 Bugs fixed in 19.1 

Preferences 

• Case 47228 

D3PLOT and T/HIS would previously not read in the preferences 
quickfind_sequential_bonus and quickfind_word_start_bonus. PRIMER too would, 

previously, not allow editing of these two preferences via the preference tree. These 

issues have now been fixed. 
 

 

  



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 19.1 

 

Ove Arup and Partners Limited | Final | October 2022  

 

Page 77 
 

3 Enhancements 

The enhancements and bug-fixes for each program have been broken down into a 
series of topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

3.1 PRIMER 

3.1.1 Enhancements in 19.0 

Adhesive 

• Case 45042 

Adhesive connections can now be created directly from solid faces. A grid is formed 
from the selected segments which (by default) will be adapted to give a quad bias, this 

will then be extruded to form a hexa biased adhesive. In this context, the object menu 
supports selection and removal from selection of segments. 

Bom 

• Case 44297 

Added PART_CONTACT option and fields (FS, FD, DC, VC, OPTT, SFT, SSF & 

CPARM8) to Bill of Materials. 

Checking 

• Case 47322 

If a model where CNTCO is not set on *CONTROL_SHELL, has 

*SECTION_SHELL with NLOC or *ELEMENT_SHELL_OFFSET, the offset will 

not apply to the contact surface. As this is likely to be a modelling error, a model 
check warning is now issued. 

• Case 46545 

A warning message has been added for models containing NLOC or _OFFSET on 
shells when CNTCO on control shell is unset. This may be deliberate, but it is more 

likely that the user will lose the expected offset on the contact surface. Note the 

PRIMER check does not actually test that the shells concerned are used in a contact. 

• Case 44841 

Custom JavaScript checks using Japanese characters now display correctly. 
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Comments 

• Case 45306 

New class 'Comment' added to JavaScript to access *COMMENT. 

• Case 45241 

PRIMER has always 'anchored' the *COMMENT keyword to the (single) next 

keyword in the input deck, so that the association between comment and following 

keyword is not lost. 
 

This logic has been extended to 'multiple anchoring' in which multiple items 

following the *COMMENT card can now be associated with it. Specifically in the 
sequence 

 
*COMMENT 

Comment lines 

*keyword 
item 1 } 

item 2 } All the items 1 to n between the two successive 

     :     } *keyword headers are associated with the *COMMENT 
item n } 

*keyword 

Contacts 

• Case 46174 

A tool has been added to the contact checker that for a single-surface contact which 

uses exempt part set (sstyp=6) removes the crossed elements from the contact. It 

moves the element with highest part label into a new part and inserts that into the 
exempted set. 

Crash test setup 

• Case 46477 

Car crash test setup script updates: 
 

-Updated the list of load cases as follows: 

(1) EuroNCAP full width frontal impact -> New test 
(2) EuroNCAP oblique pole side impact test -> Updated the test settings and barrier 

alignment 

(3) UN-ECE R32 rear impact rigid test -> Name and display image corrections 
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(4) EuroNCAP Frontal Impact -> Default barrier changed to a simplified Mobile 
Progressive Deformable Barrier (MPDB) 

(5) IIHS Side Impact -> Impact velocity updated to 60km/h 

 
-Added the option to rescan the model using the 'Restart' button in the main Window 

 

-Added the option to run 'Left' and 'Right' impact setups simultaneously by selecting 
both 'Left Impact' and 'Right Impact' in the test settings panel 

 
-Added the option to write the created *Keywords to an existing or newly created 

include file through the 'Write Keywords' pop-up window after pressing on the 'Go' 

button 
 

-Combined all rotations and translations in *DEFINE_TRANSFORMATION to result 

in one line for rotations and one line for translations whenever possible 
 

-Added the option to manually select or create a contact card in the barrier settings 
panel 

 

-Other minor enhancements 

Curve menu 

• Case 45951 

The (increasingly tall) radio button in the DEFINE_CURVE edit panel that's used to 

choose between different CURVE and FUNCTION subtypes has been replaced by a 
popup. The same has been done for the DEFINE_TABLE edit panel. 

Cut section 

• Case 20223 

PRIMER19 now supports cut planes in up to 3 different directions. Each direction has 

its individual set of Positive and Negative actions with two different modes to select 
from: Union and Intersection. 

Database 

• Case 45825 

A new 'Only visible' option has been added to the *DATABASE_CROSS_SECTION 

edit panel. This option is ON by default and determines whether blanked entities are 
included in the creation cross section planes. 
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Previous versions of PRIMER were somewhat inconsistent in the treatment of 
blanked entities. This new v19 option rationalises this behaviour. 

Deleting 

• Case 46476 

The default connection option for deletion is empty. If a user elects to leave 

connection items (such as solid welds) the deletion process was blocked. This has 
been changed so the deletion will instead proceed with no action for connections. 

Encryption 

• Case 46490 

The following updates have been added to the Encryption Tool: 

 
- The user can now add a comment line on encrypted data. 

- The user can now specify a start line for where data will be encrypted using Partial 
Encryption. 

- The user can now specify the expiration date of encrypted data. 

- A new preference has been set up so that PRIMER remembers the location of the 
GPG executable so that each time the tool is ran you do not have to find the file 

manually. 

• Case 46295 

A PGP block below a material keyword was always being associated with the material 
even if all the material values had been defined. 

If the first line of the block says 'Comment: PRIMER Full Encrypt' PRIMER will now 
treat it as independent encrypted data. 

IGA 

• Case 47415 

Added degree increase/decrease functionality in IGA Refine panel. 

Added sketch functionality for IGA_1D_BREP (trimming loop). 

• Case 47412 

Added Refine panel through which user can visualise knot grid and inserting new knot 

values for new *IGA keyword. 
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• Case 47286 

*IGA is supported for contact check and connection (weld and adhesive) creation 
with the same methodology used for *ELEMENT_SHELL_NURBS_PATCH. 

JavaScript API 

• Case 47411 

Methods and properties to create and edit *DEFINE_CURVE_SMOOTH have been 

added to the JS-API class “Curve”. 

• Case 47072 

The special encoding comment in a script now supports ShiftJIS as an encoding. 

• Case 46742 

API additions to CONTROL_MPP_DECOMPOSITION_TRANSFORMATION. 

• Case 46665 

Added JavaScript API function Colour.GetFromName returning the colour value (as 
integer) for a given core colour or user-defined colour. 

• Case 46390 

A new Evaluate method has been added to the Parameter class to be able to evaluate 
parameter expressions in a script. 

• Case 46389 

Added new JS class for *DEFINE_HEX_SPOTWELD_ASSEMBLY. 

Mesh 

• Case 45575 

Thick shells can now be split like solids. 

• Case 44870 

'Post processing' steps have been added to HAZ spotweld meshing to improve mesh 

quality by remeshing large areas and also adding local mesh modification 

improvements. The following two post processing options are available in 
Connections Table-> Options: 

 
1. HAZ mesh reconstruct: In this option, PRIMER will remesh the elements around 
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all the selected spotwelds in the model simultaneously to improve mesh quality by 
reducing tria density. 

 

2. HAZ tria reduction: This is a second operation to reduce tria density. PRIMER 
loops through all the elements and tries to merge trias to further reduce their number. 

 

The meshing routines have been parallelised to speed up the process. 

• Case 43743 

In the mesh geometry panel a user can now drag a box around nodes/edges to 

select/deselect joined edges or vertices. 

• Case 43584 

Mesh Offset command caused skewness and/or roundedness at the corners. Fixed 

now. 

• Case 38129 

An option has been added to set a user defined minimum element length/maximum 
length for meshing. You can access the meshing options from Options->'Program 

Option'->Meshing and select 'user defined meshing parameters'. 

 
Multiple PARTs and domains can now be meshed together using Meshing->Remesh 

Area option. 

Model build 

• Case 47075 

Made the 'Template' column of the 'MODEL BUILD PANEL' wider. 

• Case 46717 

Model build from keyword files tools has been improved so when the user presses 

apply, a new model is always built, i.e. we never try to build into an existing model. 

Parameter 

• Case 43520 

Enabled field TYPE in 

*CONTROL_MPP_DECOMPOSITION_TRANSFORMATION to accept 
parameters. 
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Penetrations 

• Case 47064 

A new tool (contact tree) has been added under contact Pen Check (also under 
Check). This gives a graphical display of contact condition similar to the text output 

of 'Summarise all'. All contacts with crossed edges/penetrations/untied nodes are 

listed. The contacts can be edited/pen checked directly off the tree. 

Performance 

• Case 45443 

Error messages added for *INITIAL_STRESS_SECTION when: 

- part set <psid> does not contain any valid solid parts 

- database cross section <secid> does not cut any elements of the solid parts in part set 
<psid> 

• Case 45435 

Added triad size options to the 'Display Options' panel. 
- The 'minimum factor' controls the minimum size of triads 

- The 'scale factor' scales the triad size 

• Case 45434 

The graph area as well as other buttons on the DEFINE_TABLE edit panel will now 
automatically scale (expand) as the window is dragged wider or taller. 

• Case 45432 

A switch 'check for item in different include' has been added to the front panel of 

Model Modified. The options for Part and Connection comparison are now OFF by 
default. 

• Case 45430 

For Merge -> Apply -> Custom merge -> Basic model data. A new '?' button is added 
for each type. It will generate a panel that lists all clashing items of the relevant type 

and allows users to 'Sketch all' & 'Only all' items on the panel as well as 'Blank', 

'Unblank', 'Only', 'Sketch' & 'Edit' each individual item. 

• Case 45429 

Improvement of the performance of the LS-DYNA output reader. Now the output 

files are not always re-read when re-loading the treeview (which is slow). They are 
only re-read if any of them has been modified. 
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• Case 45424 

Some changes to renumber panels: 
- Visualise panel (include mode): changed format of include ID from 'I xx' to '(xx)' 

- Renumber includes panel: added include ID '(xx)' before file name + left justify the 

file name column 
- Renumber includes panel: adjusted the width of the file name column according to 

the longest file name.  If the file name is too long, it’s truncated to fit the column. 

- Visualise panel (include mode): If file name is too long, truncate it to fit the column. 
Functionality improved to deal with different fonts and font sizes. 

- Renumber contents panel: Increase width of columns to accommodate large labels 
- Renumber selection panel: The width of the 2nd column will increase when large 

labels are detected. Decrease the increment slightly to reduce waste of space. 

- Renumber includes panel, sort options: Changed 'Retain original order' to 'Sort by 
include ID', added 'Sort by alphabetical order' and changed the sort text displayed 

from 'Sort by ...' to 'Sorted by ...' for clarity. 

- Renumber includes panel: remove 10-row limit so we can see as many in the list as 
the panel will allow on panel resize 

- Renumber includes panel & Visualise panel (include mode): add visualisation 
(Blank, Unblank, Only) drop-down for master & include files 

• Case 44626 

Remesh area tool in PRIMER was remaking all connections on the target part. In v19 

only connections where the mesh has changed are remade. 

• Case 44571 

On completion of recursive find attached, the recursive option is now switched off. 

• Case 44553 

The Oasys suite software has always had the option to open 'maximised' on the 
desktop, but this has suffered from two problems. 

 

Problem #1 was that for historic reasons the default in the software itself was *not* to 
open maximised, yet we made this the de facto default by shipping with a preference 

'oasys*maximise: true' in the standard oa_pref file which specified opening 

maximised. 
 

This inconsistency is now removed: the software will open maximised by default, 
even if that preference is removed. It is still possible to open at a reduced size (about 

70% size, north east justified on the display) by setting preference 'oasys*maximise: 

false' 
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Problem #2 occurred only on Windows platforms: 

 

+ Open an Oasys application in a maximised state. 
+ Moved another window partially in front of the Oasys window. 

+ Move the mouse (no click required) into the Oasys window 

 
... and the Oasys application would jump in front of the other window. This only 

happened once per session, the first time the sequence above was performed, 
thereafter the window stacking order would not be changed. 

 

This was caused by the way a maximised window was first mapped, causing the 
Windows operating system to be a bit confused about its status. This has now been 

fixed. 

• Case 44552 

The connection panel now offers update levels. ‘Full recheck’ (default), ‘Reduced 
recheck’ and ‘No check’. 

If data is changed in the model, the connection status may be out of date so a ‘Full 
recheck’ is the safest option. However, if this is proving too slow, less rigorous 

options are now available. 

• Case 44550 

Added a new 'Go to label' menu in the Keyword editor, used to automatically jump 
the scroll bar to the row of the labelled entity of choice. 

Sensor 

• Case 45045 

Added a preference 'sensor_keyout_pattern' to switch between 'coupled' and 'normal' 
way of keyout for *SENSOR. 

User interface 

• Case 47895 

Two Favourite menus have now been added to PRIMER, one for Tools and one for 

Keywords. These menus can be populated with extant Tools or Keywords that users 
are interested in an order that they prefer. Both menus can be populated either using 

preferences or by clicking the respective 'Custom...' buttons. 
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The Favourites menu for Tools can contain any button from the Tools menu, 
including sub-tools such as Tools->Safety->FMH->FMH Markup. 

 

The Favourite menu for Keywords can contain any top level keyword from the 
'Volumes I & II' and 'Volume III' tabs. Popups are mapped on buttons to allow users 

to access sub-keywords such as BOUNDARY_PRESCRIBED_MOTION. 

• Case 45925 

When interactive panels have been reconfigured, changing the button layout, we had a 
problem that macros recorded on the old panel would probably not work in the new 

because their buttons had disappeared or changed too much. 
 

PRIMER has been enhanced so that the old buttons that are no longer visible are still 

remembered. This means that they are in fact still there, just not visible, and while 
they can't be clicked on interactively old macros that use them stand a much higher 

chance of working. 

 
(This is not a panacea: if a panel changes drastically it may not be possible to retain 

old functionality, but it should help.) 

• Case 43027 

The radio buttons at the top of the DEFINE_CURVE and DEFINE_TABLE panels 

indicating curve and table types have been converted to drop-downs (popups). 

• Case 42785 

The old Quick-Find button has been made more prominent in the form of a Search bar 
located in the top menu bar. The existing shortcut key (#) can still be used. Search 

options can now be controlled from Options → Program Options → Search. 

User defined 

• Case 42000 

The old colour popup in PRIMER has been replaced with the new colour popup 

which we have currently in D3PLOT and T-HIS. Users can either choose an existing 

core colour or create their colour from the palette. The user defined colours can also 
be saved and read back 
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3.1.2 Enhancements in 19.1 

Crash test setup 

• Case 48571 

In the Batch Crash Test Setup script, the user can now read additional test, vehicle and 
barrier settings from a preference folder that is not located in the default home 

directory. 

• Case 48408 

In the Crash Test Setup script, if the user selects the 'Use Rigidwall' load case, they 
can now import/select their own *Rigidwall for positioning. 

• Case 48407 

The Crash Test Setup script now remembers the path the user sets as the home 

directory. This means that the home directory path (set at the beginning) does not 
change back to the default every time the script is restarted. 

Dummies 

• Case 48558 

The state of the 'Predictive Pick' functionality was not consistent across various panels 
in the Dummy positioning tool. Fixed this. 

Geometry 

• Case 49176 

The JT geometry reader has been removed from PRIMER. 

Include 

• Case 48806 

In the 'Model Include File Structure' window, the red-lighting of a modified Include 
will disappear if the include is overwritten so long as the include has no modified 

child Includes.  

The master Include red-lighting will be removed if all Includes are unmodified and 
there is nothing modified in master file.  
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3.2  D3PLOT 

3.2.1 Enhancements in 19.0 

Airbag 

• Case 44945 

D3PLOT 19.0 has been updated to handle the new data component ‘Ratio PA’ that is 
written to the CMPFOR file for particle airbags by LS-DYNA R11.2.2 onwards. 

 

Support has also been added for two further (undocumented) data components, 
believed to be Pressure + and -. 

Animation 

• Case 43069 

The way that images and movies are captured in D3PLOT has changed. Previously if 

you created an animation in D3PLOT and then captured it as a movie, if you then 
went back to play the animation again, D3PLOT had to rebuild the animation again. 

Now, D3PLOT no longer has to rebuild the animation and can play it again 
immediately. 

 

This change does not apply when generating output for D3PLOT Viewer. 

Cut section 

• Case 44575 

When dragging cut planes with the middle or right mouse button for rotation, often 

the direction of the rotation was unexpected. In D3PLOT 19.0 this behaviour is now 

consistent with dragging cut planes in PRIMER. 

• Case 41554 

D3PLOT now supports cut planes in up to three different directions. If more than one 

direction is defined, D3PLOT 19.0 draws the intersections of each plane with the 
model simultaneously, whereas the drawing actions on the positive and negative 

actions for each plane default to Omit. 
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Data components 

• Case 46119 

New data components have been added for yield utilisation factor and yield utilisation 
percentage. 

Image 

• Case 47367 

D3PLOT exports true beam sections to D3PLOT Viewer if these are switched on 

during export. 

Integration 

• Case 47372 

Now, when you open a template in REPORTER, if the saved values of 

DEFAULT_DIR and DEFAULT_JOB are empty or default, and if REPORTER was 

launched from D3PLOT or T/HIS in a linked session, then the values of 
DEFAULT_DIR and DEFAULT_JOB are updated to match the path and filename of 

the current model open in D3PLOT or T/HIS. This means that when capturing items 
from D3PLOT and T/HIS into templates, the variables will be used in place of 

hardwired paths (previously you would have had to edit those manually). This makes 

it easier to run the template on multiple different models. 

JavaScript API 

• Case 46666 

The function Colour.GetFromName has been added. It returns the colour value (as an 

integer) for a given core colour or user-defined colour. 

Menus 

• Case 45479 

Colours can now be set by include on the Part Tree and Properties menu similarly to 
the colours by include available in Quick Pick. 

 
Colours can now also be set by model in all these menus. 

 

Furthermore, in Part Tree, Properties and Quick Pick menus, colours for parts and 
elements can now be set by material, by section or by assembly. 
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• Case 44984 

The full range of colours is now available for Target Marker via a new colour popup 
menu in the Utilities → Target Marker menu. 

Performance 

• Case 46553 

The options used to arrange windows and pages in both D3PLOT and T/HIS have 

changed significantly. The order of D3PLOT Windows and T/HIS graphs can now be 
controlled on each page. Where windows share a common border, it is now possible 

to drag that border and resize all of the windows attached to it at the same time. 

 
For more details on these changes please see the New Features PowerPoints and the 

user manuals. 

• Case 44576 

The way that images and movies are captured in D3PLOT has changed. Previously if 

you created an animation in D3PLOT and then captured it as a movie, if you then 

went back to play the animation again, D3PLOT had to rebuild the animation again. 
Now, D3PLOT no longer has to rebuild the animation and can play it again 

immediately. 

 
This change does not apply when generating output for D3PLOT Viewer. 

Selection 

• Case 12172 

The Quick Pick selection methods now include options to pick by polygon or by 
circle as well as by the default rectangular window. 

User interface 

• Case 47814 

The old Quick-Find button has been made more prominent in the form of a Search bar 

located in the top menu bar. The existing shortcut key (#) can still be used. Search 
options can now be controlled from Utilities → Search Opts. 
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User defined 

• Case 46600 

When plotting user-defined data from .ubd files, if the user had the ubd_file_location 
preference set and valid data in the directory it was pointing to, but also valid data in 

the model directory, data would be set to 0 for all states. 

 
Now, D3PLOT can correctly read data from both locations. In the case where 

components with the same name exist in both locations, data from the location 

specified by the preference will take priority, but a warning will be displayed so it is 
clear what has happened. 
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3.3 T/HIS 

3.3.1 Enhancements in 19.0 

Database 

• Case 43346 

Added support for 15 new data components in the Discrete Beam Menu from the 
DISBOUT file. Modified the labels to show local co-ordinates. 

Integration 

• Case 47373 

Now, when you open a template in REPORTER, if the saved values of 

DEFAULT_DIR and DEFAULT_JOB are empty or default, and if REPORTER was 
launched from D3PLOT or T/HIS in a linked session, then the values of 

DEFAULT_DIR and DEFAULT_JOB are updated to match the path and filename of 

the current model open in D3PLOT or T/HIS. This means that when capturing items 
from D3PLOT and T/HIS into templates, the variables will be used in place of 

hardwired paths (previously you would have had to edit those manually). This makes 
it easier to run the template on multiple different models. 

JavaScript API 

• Case 46667 

The function Colour.GetFromName has been added. It returns the colour value (as an 

integer) for a given core colour or user-defined colour. 

Menus 

• Case 45232 

Made changes to colour popup visibility for consistency with D3PLOT. 

• Case 45014 

Added a help button to the user colour popup. 

Operations 

• Case 46420 

A Bessel filter operation has been added to T/HIS. 
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• Case 43729 

Included in T/HIS 19.0 as a JavaScript is the MADM Correlation Tool. The minimum 
area discrepancy method (MADM) is ideal for correlation between LS-DYNA 

simulations and physical tests when force versus deflection is the relationship of 

interest, and offers benefits over other correlation methods that focus on parameters 
versus time. The MADM Correlation Tool was developed in collaboration with the 

University of Coventry. 

Read 

• Case 42578 

Added support for Mass and inertia components for both binout and Ascii ssstat 
output. 

• Case 47175 

Added support for JNTFORC output from LS-DYNA R13 onwards. Main updates 
include support for cylindrical joints when read via LSDA or ASCII. 

User interface 

• Case 47815 

The old Quick-Find button has been made more prominent in the form of a Search bar 

located in the top menu bar. The existing shortcut key (#) can still be used. Search 
options can now be controlled from Options → Settings → Search. 

• Case 42292 

The Images menu has been made more consistent between D3PLOT and T/HIS. 

Write 

• Case 45672 

Limited support for reading HDF5 format files is now available. 
 

T/HIS is now able to read in HDF5 files which contain either Atomic Float datasets or 
Compound datasets that contain Floating point data. Data can be selected interactively 

and plotted either against Index or against another column of data within the HDF5 

file. 
 

Please note that FAST-TCF, JavaScript and support for writing HDF5 files is not 
currently implemented but we are looking to support this further in a future release. 
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3.3.2 Enhancements in 19.1 

Curves 

• Case 45691 

Included in T/HIS 19.1 as a JavaScript is a new correlation tool for CORA and ISO-
18571. It can be run by opening the JavaScript panel and selecting CORA → CORA 

(CORrelation and Analysis). For more information about this new tool, read 

Appendix F.1 of the T/HIS manual, and follow the tutorial (Help → Tutorials → 
CORA and ISO-18571). 

Operations 

• Case 49191 

It is now possible to automate a MADM correlation assessment by calling it from 

another script. For instructions, follow the new tutorial (Help → Tutorials → MADM 
Worked Example). 
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3.4 REPORTER 

3.4.1 Enhancements in 19.0 

Error trapping 

• Case 39802 

We have improved the handling of errors and warnings when generating content in 
REPORTER. Previously, you had to decide whether to stop generating the report 

before being able to see the error message. Now, you get to examine any errors and 

warnings before deciding whether to proceed. 
 

When generating a report, if an error is encountered, the Logfile window will now 

appear immediately. This gives you the opportunity to examine the error before 
choosing whether to ‘Stop’, ‘Continue’ (Logfile will reappear if another error occurs), 

or ‘Continue to end’. 
 

You can now navigate up and down through the errors and warnings in the log file 

using the controls provided. 
 

You can prevent the Logfile window from appearing when an error occurs by 

unchecking ‘Check for errors during report generation’. In this case, you will still be 
asked at the end of generation if you would like to inspect the log file. 

 
Also, the following options are now automatically saved to your REPORTER 

preferences upon selection: 

- Include debug information from PRIMER, D3PLOT, and T/HIS 
- Don't automatically exit from PRIMER, D3PLOT, and T/HIS after item generation 

- Check for errors during report generation 

Integration 

• Case 44209 

Now, when you open a template in REPORTER, if the saved values of 

DEFAULT_DIR and DEFAULT_JOB are empty or default, and if REPORTER was 

launched from D3PLOT or T/HIS in a linked session, then the values of 
DEFAULT_DIR and DEFAULT_JOB are updated to match the path and filename of 

the current model open in D3PLOT or T/HIS. This means that when capturing items 

from D3PLOT and T/HIS into templates, the variables will be used in place of 
hardwired paths (previously you would have had to edit those manually). This makes 

it easier to run the template on multiple different models. 
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Preferences 

• Case 16729 

Drive mapping support has been added to REPORTER and can be controlled 
using the oasys*drive_? oa_pref settings. 

Scripting 

• Case 47275 

Unlike PRIMER, D3PLOT and T/HIS, REPORTER does not support the Use 

function, or JavaScript modules. To help address this, a new ‘Script File’ item has 
been added to REPORTER. Script File items have all the features of Script items, 

except that rather than containing an embedded JavaScript, they point to an external 

script file. This allows you to edit the script in your preferred editor. Furthermore, 
since the REPORTER JavaScript environment persists for the duration of the 

REPORTER session (and is shared by all scripts), you can now create one or more 
Script File items containing any common functions, followed by one or more Script 

File items that use those functions. This should provide much of the benefits of the 

Use function and JavaScript modules available in PRIMER, D3PLOT and T/HIS. 

Standard templates 

• Case 47989 

In the head impact templates, to improve integration with the PRIMER HIC Area 

Calculator tool, additional comment lines are now written to .blob files, containing the 

absolute path of the cur file as well as keyword paths in the data lines. 

• Case 46895 

REPORTER 19.0 comes with the new IIHS Side MDB Impact 2021 template, which 

follows the IIHS Side Impact 2.0 protocol and rating guidelines. There is also a 
Structure Only version of the template that can be used when occupants are not 

present in the simulation. 

• Case 46894 

The IIHS Front ODB and SOB templates have been updated to the latest 2021 
protocols. 

• Case 46036 

REPORTER 19.0 comes with the new Euro NCAP Far Side Impact 2022 template, 
which follows the Far Side Test and Assessment Protocol v2.1.1. 
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• Case 42950 

REPORTER 19.0 comes with an ICFD Assessment library template, which can be 
found in the new ICFD tab. The template is designed to be used with the ICFD Setup 

tool in PRIMER. 

• Case 42245 

The Euro NCAP Side MDB and Side Pole templates have been updated to the latest 
2022 protocols (AOP v9.1.3). The templates also have a new option to output a CSV 

file containing maximum intrusion data required by the new Far Side Impact template. 
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3.5 SHELL 

3.5.1 Enhancements in 19.0 

Menus 

• Case 37087 

Added hover text strings for various panels widgets in SHELL to explain their 

functions better. 

Preferences 

• Case 47527 

Added new preferences to set up the default LS-DYNA executable - 
'default_ls_dyna_executable'. 

Also added another set of preferences to setup default MPI type and its executable 
path: 'default_mpi_type' and 'default_mpi_executable' 

User interface 

• Case 47529 

Added buttons in the LS-DYNA submission panel to view/edit these SHELL system 

files in the text editor:'dyna_versions', 'oasys_queue' and 'oasys.submit'. 

• Case 46577 

SHELL now supports two new sense switches endtime and SWE for LS-DYNA V19. 

User defined 

• Case 47475 

SHELL is now saving the paths to the keyword files that have been recently submitted 

for the LS_DYNA run via the SHELL. The list of these file paths is available in a 
drop-down menu attached to the 'Input File' widget in the 'LS-DYNA Submission' 

panel. 

• Case 47474 

SHELL is now saving a list of recent 'Command-line Expression' commands. These 

command-strings are available in a drop-down menu attached to the 'Command-line 

Preview' widget in the 'LS-DYNA Submission' panel. 
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• Case 46263 

Added LS-DYNA command line preview and expression to SHELL submission 
panel. Also added edit widget to edit the command line using a text editor. 
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3.5.2 Enhancements in 19.1 

Filename 

• Case 48259 

Added a new 'input' text field for GMINP(.gmbin) in Input/Output tab of LS-DYNA 
Submission panel to give GMINP filenames that are different to the keyword file 

under submission. 

User interface 

• Case 49547 

Added Help buttons at the top right corner of all the SHELL 'Options' panels and the 
LS-DYNA Submission panel, to launch appropriate SHELL manual pages. 
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3.6 Oasys 

3.6.1 Enhancements in 19.0 

JavaScript API 

• Case 46441 

The console API (as specified in https://console.spec.whatwg.org) has been added to 
the JavaScript implementations in all our programs. This will allow console.log() etc. 

to be used in scripts. 

• Case 46401 

A bar showing garbage collection memory usage has been added to the JavaScript 
debugger. 

 

https://console.spec.whatwg.org/



